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1

Getting Started

ColorBurst® is a Windows® PostScript® Language Level 3 Compatible 
Raster Image Processor (RIP) that produces a CMYK color composite for 
printing to a large format inkjet printer. Color correction is performed 
on-the-fly during output to the printer.

ColorBurst supports Scitex CT, CMYK and RGB TIFF, JPG, PDF, and 
PostScript file formats. In addition, Crosfield’s “Disk Data Exchange 
Format” (DDEF), often referred to as “shared SCSI disk format,” is also 
supported in all Professional versions of ColorBurst. The RIP is based on 
the 5D Solutions Ltd. JAWS RIP. Supporting all Type1 and TrueType fonts, 
ColorBurst is implemented as a 32-bit Windows application. Multiple-
page output is supported from PostScript and PDF files.

Hardware Requirements
To run ColorBurst, your computer should meet the following 
requirements.

CPU	 Pentium IV 2.0 GHz CPU or faster with built-in math 
coprocessor.

Disk Space	 1 GB of local hard disk space is required. Network 
storage can be used but it usually results in slower 
throughput. If you want to save intermediate files 
created by the PostScript interpreter for future use, or 
if your files are very large, 40 GB is recommended.

RAM	 1 GB RAM is recommended.
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USB port	 An available USB port is required for the ColorBurst 
dongle (keycard).

Display	 1024x768 minimum resolution is required. A 17” or 
larger monitor is recommended.

DVD Drive	 The ColorBurst installer ships on a DVD. A DVD-ROM 
or DVD±RW drive is required to install ColorBurst.

Software Requirements
Windows 2000, 2003, or XP is required; XP is recommended. You must 
be logged on at the administrator level to properly install ColorBurst.

ColorBurst Installation Procedure
Make sure that Windows is already installed and running on your 
computer. You must be logged on at the administrator level to prop-
erly install ColorBurst.
Insert the ColorBurst DVD into your DVD-ROM or DVD±RW drive. 
The installer will automatically launch (or open the DVD manually if 
you have autorun turned off).
When the installation starts, follow the instructions on your screen. It 
is important to never install a new version of ColorBurst over an exist-
ing version; always select a new folder to install ColorBurst.
Plug the supplied ColorBurst dongle into the USB port (a USB dongle 
is required). 

The ColorBurst installation program creates a program group containing 
the ColorBurst icon. The ColorBurst installation process is now complete.

ColorBurst Dongle Utilities
As of ColorBurst version 7.6, a USB dongle is required—the older paral-
lel dongle has been replaced by USB. All parallel ColorBurst dongles 
must be converted to USB. To convert a parallel dongle, please contact 
ColorBurst Systems to purchase a dongle conversion kit.

The ColorBurst USB dongle driver is automatically installed during 
ColorBurst installation. However, if the driver needs to be reinstalled later 

1.

2.

3.

4.
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for any reason, it is named Install USB Keycard.bat, and can be found in 
the ColorBurst\System folder.

Starting ColorBurst
When ColorBurst is started the main ColorBurst window consisting of 
a toolbar, work area, and message window is displayed. The Name of 
the currently selected Printer Setup file is displayed in the toolbar. When 
Auto Set Default Positions is selected in the Windows menu, the win-
dows will be positioned to fit the main ColorBurst screen exactly when 
the Layout, File Info, and Message windows are all displayed.

Name of currently selected Printer Setup file

Status bar

Toolbar

Message Window

Figure 1.1. The main ColorBurst window.

Each of the menu items on the toolbar—File, Printer Setup, Options, 
Spooler, Windows, and Help—is described in the following sections of 
this manual.
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2

File Menu

The first menu item is File. When selected, there are five items avail-
able (including Exit) if no files are currently open. The File Info, Convert, 
Convert As, and Scale&Rotate items are not available until a file is 
opened.

Figure 2.1. The ColorBurst File menu.

Open
Clicking on Open will display the Open dialog. This dialog allows you 
to open a file (CT, CLF, EPS, TIFF, JPG, etc.) from any available local or 
network drive and directory and add it to the current layout. If no layout 
was previously in effect and displayed on-screen, then a layout window 
is created, representing the size of the media. If you are running on a 
LAN (Local Area Network) or WAN (Wide Area Network), your network 
rights to your login will determine the drives and directories to which you 
have access.



� · File Menu	 Layout Series

When the file you wish to open is displayed in the File Name field, 
double-click on the file to open it, or click on the file once to select it, 
then click on Open to open the file. Of course, the file name may always 
be entered manually in the File Name entry box.

Figure 2.2. The Open dialog.

If a layout is already in effect when a file is selected, it is added to the 
existing layout. Error messages will inform you if the file is invalid (wrong 
file type). If it cannot fit in the current layout, the message “Image will 
not fit in layout. Add it anyway?” appears. If you choose to Add the file, 
it is placed in the layout if any part can fit. If there is no room to place 
even the smallest part of the image in the layout, the same message is 
displayed until No or Cancel is selected.

When a file is opened and added to the layout, it will appear either as an 
outline with the file name or as a bitmapped preview of the file. When a 
file is ripped in ColorBurst, a preview is saved for the file and will be au-
tomatically used when it is opened again (the preview file is saved in the 
Bitmaps folder). Otherwise, an outline with the file name inside is shown 
until the file is displayed and a bitmap preview is created. Bitmap preview 
files are created for screen display only and are not antialiased. The 
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bitmap image size may be set to Low, Medium or High in the Window 
Options dialog.

NOTE: 	 If a file is modified/saved after being ripped in ColorBurst, 
the preview bitmap is no longer valid. The file will appear 
as an outline in the Layout window until it is ripped again in 
ColorBurst.

To delete a bitmap preview file through ColorBurst, select the image in 
the layout. While holding the Control key, click the image. A dialog will 
appear asking if you want to delete the bitmap for this file; click Yes to 
delete the preview. The file will now appear as an outline in the Layout 
window and must be displayed again to create a new preview. It is help-
ful to delete a bitmap preview file when changing display resolutions or 
ICC display profiles; deleting and re-displaying the file will update the 
bitmap preview with the new settings in effect.

Restore Last Job
The Restore Last Job item will open the last layout that was printed. If 
you close a layout before it is printed, the layout information is lost. 

File Info
The File Information dialog serves two purposes. First, it lets you verify 
that the selected file is indeed the file you want to process. Second, it is 
a shortcut to start processing, i.e., printing, displaying, or modifying the 
layout or images. This dialog appears automatically after you select a 
valid file (TIFF, JPG, CT, CLF, EPS, etc.) in the Open dialog. You can also 
display this dialog by choosing the File Info menu item under the File 
menu on the menu bar or by clicking on a file in the Layout window.

Once a valid file is selected in the Open dialog, it remains selected until 
you open another file, add another file to the layout, or select another 
file in the Layout window. The Step&Repeat, Scale/Rot, and Delete but-
tons, as well as the Display command, process the selected file. At any 
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time you may want to display this dialog to be sure that the file you want 
to process is currently selected.

Figure 2.3. The File Information dialog. This dialog appears when any image is opened 
(File > Open). It can also be accessed by selecting File > File Info.

The top portion of the dialog gives general information about the se-
lected file. This information includes the file name, drive/directory path, 
file type, and file size.

Change Layout
The middle part of the dialog is the Change Layout group. “Layout” 
refers to ColorBurst’s ability to position and print multiple files at a time. 
The command buttons here can be executed with a single mouse click.

Add button
The Add button allows you to add an illustration to the current layout. It 
is equivalent to closing the File Information dialog and issuing an Open 
command under the File menu on the menu bar. The Open dialog dis-
plays, allowing you to add an illustration from any available path. If the il-
lustration that you select is already in the layout displayed on the screen, 
you will be asked to confirm that you want to add a duplicate.
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If the file selected is valid, it will become the currently selected file. 
Information about the file will be displayed in the top portion of the File 
Information dialog, and a blue outline representing its size and position 
will be added to the layout window.

Step&Repeat button
The Step&Repeat button opens the Step and Repeat Options dialog. 
This dialog lets you specify how to duplicate the selected image in the 
Layout window.

Figure 2.4. The Step and Repeat Options dialog. This dialog can be opened by clicking 
the Step&Repeat button in the File Info dialog.

There are three default selections when the dialog opens—Fill layout, 
Fill width of layout, and Fill height of layout. These three options work 
together. When these three options are selected, multiple copies of the 
selected image are added to the layout, as many times as it will fit. If the 
selected image is the only image in the layout, Step&Repeat performs 
the expected task of filling the layout with only this image. Other images 
may be in the layout when you select the Step&Repeat button. The 
space remaining on the media is used to try to fit the selected image us-
ing the current best-fit formula in effect.

You may specify a number of images to add to the layout by entering a 
value in the Limit total to entry box. For example, if you enter a value of 
5, the image will be repeated five times in the Layout window, as long as 
there is enough space in the Layout window for all five images to fit.
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NOTE:	 If you enter a number of images, the selected image is con-
sidered the first image, and more images are added to make 
up the total number of images.

The Fill columns group lets you add images in a specified number of 
columns. The Rows group lets you add images in a specified number of 
rows. If both of these options are selected, the image will be repeated in 
the specified number of columns and rows.

Scale/Rot button
The Scale/Rot button allows you to scale and/or rotate the currently 
selected image through the Scaling & Rotation dialog. This button is 
equivalent to the Scale&Rotate menu item. See the description of the 
Scale&Rotate menu item for detailed information.

Refit button
The Refit button repositions every illustration in the layout according to 
the current best-fit formula in effect. You may change the best-fit formu-
la in the Layout Options dialog. The main use of Refit is to undo manual 
repositioning that you may have made using the mouse or Reposition 
button, or to close a hole in the layout created after a file is deleted.

Reposition button
The Reposition button opens the Set Current Position dialog. Entering 
values for In and Down places the upper left corner of the selected im-
age at those exact coordinates in the layout. The default unit of measure 
used here is set in the Printer Options dialog. 

Figure 2.5. The Set Current Position dialog, opened by clicking the Reposition button 
in the File Info dialog.
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Write CLF button
You can save a layout at any time by selecting the Write CLF button. 
Color Layout Format (CLF) files contain pointers to one or more illustra-
tions that make up a layout. 

You open CLF files like any other type of image file, and the extension 
.CLF is a defined search extension in the Open dialog. All files pointed to 
within the CLF file are added to the current layout as if you had issued 
an Open command or selected add in the File Information dialog for 
each image individually. The last image found in the CLF file becomes 
the currently selected file and its information is displayed in the File 
Information dialog.

The CLF contains the positions of all files in the saved layout. An attempt 
is made to put the files in the same positions that they were saved in, 
if there are no files in the current layout. If there are files in the current 
layout when the CLF is read, each file from the CLF is repositioned as it 
is added to the layout. If you use a “best-fit” formula that repositions all 
files whenever a new file is added, the positions of the files in the CLF 
may change even if there are no files in the current layout.

If job titles were in effect when the layout was saved, the positions have 
been altered to allow room for the titles. If image positions are main-
tained and job titles are no longer in effect, there will be extra space 
around the images. More significantly, if job titles were not in effect 
when the layout was saved and they are when you read the CLF, images 
may overlap because of the additional room needed for titles. If this pos-
sibility exists, you should select the Refit button in the File Information 
dialog to reposition all images after reading the CLF file.

Saving a layout is the only way you can send a cropped, scaled, rotated, 
or tiled image to the spooler. The Write CLF button displays the Save As 
dialog for saving the current layout under any name and in any directory 
that you choose. If you are adding many images to a layout, it is a good 
idea to save the layout periodically.
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NOTE:	 Spooler uses CLF files when layouts are in effect. Files enter-
ing the queue monitored by Spooler are pointed to by a 
CLF file named SPOOLER.CLF, so you should avoid using this 
name for your layout. See Spooler Layout Options for more 
information.

Delete button
The Delete button deletes the currently selected file from the layout. 
Before deleting, you will be asked to confirm that you really want to 
delete the file. After you confirm the deletion, the layout is checked 
for duplicates. If found, you will be asked whether all copies of the file 
should be deleted. Answering Yes deletes all copies, and answering No 
deletes only the selected block from the layout.

Clear button
The Clear button clears every file in the layout, leaving an empty layout 
window. This inhibits printing since there must be at least one file in the 
layout for the Print command to work.

Select a File Option
The lower portion of the File Information dialog is the Select a File 
Option group. This group allows you to start processing the selected file. 
Selecting one of these options and choosing the Start button is exactly 
like selecting one of the options under the File menu. The Print radio 
button (the default selection) is equivalent to the Print menu item, the 
Display radio button is equivalent to the Display menu item, and the 
Convert To and Convert As buttons are equivalent to the Convert and 
Convert As menu items.

Figure 2.6. The Select a File Option settings in the File Info dialog. The Start button is 
used to begin the process selected here (Print, Display, or Convert).
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Start button
If you are ready for processing, select the File Option and click the Start 
button or press <Enter> on the keyboard. The File Information dialog 
disappears and printing, displaying, etc. begins immediately.

It is not necessary to start processing immediately. If, for example, you 
need to set up Printer or PostScript Options, or if the file selected is 
not the file you want, simply click the Cancel button or press <Esc> on 
the keyboard. The File Information dialog will disappear, but the file is 
still selected and the layout is still in effect. The next time you select 
Display, for instance, the currently selected file will display on the screen. 
Selecting Print will print the layout.

Convert, Convert As 
ColorBurst allows you to create TIFF and Scitex CT files through the File 
menu and the File Information dialog box, as well as the Spooler.

Figure 2.7. The Convert and Convert As menus.

The Convert command is only available after a file has been selected. 
The conversion taking place is from any image format, such as an EPS 
or a TIFF, to a TIFF or a Scitex CT, as selected in the sub-menus of the 
Convert and Convert As menus. The file is saved with the current file 
name and a .TIF or .CT extension, depending on which file type is se-
lected, to the path specified in Output Directory of the Postscript/Layout 
Output File Options dialog box.
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When a file is converted, the progress of file conversion is shown in a 
progress window. A gauge at the center of the window shows the per-
centage completed. This process may be stopped at any time by select-
ing the Cancel button or pressing <Esc>.

Figure 2.8. The Convert progress window.

Convert As allows you to name the output file. The file type may also be 
selected by choosing either “To TIFF” (CMYK TIFF) or “To CT” as a sub-
menu selection from Convert and Convert As.

The naming convention (.TIF or .CT) used for Convert is also the default 
name for Convert As. Note that the default directory for this dialog box 
was specified as the Output Directory in the Postscript/Layout Output 
File Options dialog box. Also note that like files cannot be converted; a 
file that is already a CMYK TIFF will not convert to a CMYK TIFF, nor will 
a CT file convert to a CT (an RGB TIFF can be converted to a CMYK TIFF).

Print
The Print command starts the printing process, which always includes 
all images in the current layout rather than single files. A single file is 
printed when it is the only image in the layout.
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If no file has been selected or if there is no current layout, i.e. the layout 
window is not displayed on the screen, Print acts exactly like Open to 
allow you to add a file to the current layout.

When one or more files have already been added to the layout and Print 
is selected, a Print progress window appears. This screen gauges the 
progress of the RIP and the printer.

The progress of the printer is graphically enhanced to better show the 
actual printing. The progress “bar” is a thumbnail of the current layout 
on the media. Any offsets in effect are shown in the thumbnail. As a 
portion of the layout is printed, it turns gray. The actual percent of the 
entire layout that has been sent to the printer displays to the right of the 
thumbnail. You may abort printing at any time by selecting the Cancel 
button or pressing <Esc> on the keyboard.

Figure 2.9. A progress window is shown during printing.

The position of images on the print media, the number of copies to 
print, etc., are controlled by the Printer Options dialog.

Display
The Display command is used to display, crop, and tile an image on 
the screen, and has a shortcut to scaling and rotation. You can also 
double–click an image preview in the Layout window to open the 
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Display window. When an image is displayed, it appears in a scalable, 
moveable window, initially centered in the main ColorBurst window. 
If rulers are turned On in the Window Options dialog (found under 
the Windows menu), they will appear at the top and left side of the 
Display window. The file name is shown at the top of the window. Four 
image modification buttons (Crop, Crop to Size, Tile, and Scale/Rotate) 
appear at the bottom left corner of the window. Close and Restore 
buttons appear in the center bottom. Four zoom buttons (Zoom to 
Marquee, Zoom Up, Zoom Down, and Best Fit) and a zoom pop-up 
menu are located to the right.

When you Display a multipage PostScript file, each page is displayed 
individually. The page displayed is the page that is currently selected in 
the layout.

Figure 2.10. The Display window. A file can be displayed by double-clicking the file in 
the Layout window, or by selecting Display and clicking Start in the File Info dialog.

The size of the display window is proportional to the size of ColorBurst’s 
main window. ColorBurst tries to fit one dimension of the display 
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window to the size of the main window. All images (TIFF, JPG, CT, etc.) 
are run through the PostScript RIP and scaled to fit the display window. 
Standard Windows moving and sizing of boxes with the mouse or key-
board is supported. If the image is resized, it is always kept proportional 
so the image may not always fill one of the dimensions of the display 
window. Only one image can be displayed on the screen at a time.

Image Zoom buttons
The four zoom buttons and the pop-up menu at the bottom of the 
Display window allow you to zoom in and out of an image. These tools 
are the same as the ones located in the Layout window; you can zoom 
in both the Layout and Display windows. The maximum zoom percent-
age is 1600% and the minimum size is 25%.

Figure 2.11. The Zoom buttons at the bottom of the Display window.

To use the Zoom to Marquee button, click it once to select it. Then click 
and drag over the image to select the area to zoom in on. The Zoom Up 
and Zoom Down buttons are clicked once to make the image zoom in 
or out. The Best Fit zoom tool is clicked once to return the image to fit in 
the window. Best fit displays 100% of either the width or height for the 
current display window size.

The zoom pop-up menu is used to set the zoom to a certain percentage 
of the original size. You may select any of the preset percentages or type 
a number into the box for a custom zoom. The Best Fit options will resize 
the image to fill one dimension of the Display window, either the width 
(Best Fit Horiz.) or the height (Best Fit Vert.).

When an image is zoomed up and exceeds one dimension of the Display 
window, a scroll bar will appear; this allows you to scroll to see the rest 
of the image. The scroll bar will disappear if you zoom down and it is no 
longer needed.
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Cropping
Cropping is available in the Display window. To frame an area within the 
display that you want to crop, simply hold down the mouse button and 
drag the mouse to select the area. Once an area has been selected, you 
can drag the frame around to get the exact crop. You may also resize the 
crop box. As you move the cursor within range of a side or corner of the 
crop box on the screen, you will see the cursor change to the resize cur-
sor arrows. If you click the mouse when this cursor is showing, you are in 
resize mode. The regular (arrow) cursor will be positioned at the side or 
corner and normal Windows resize functions will take place. 

Click the Crop button (the first button) to reduce the original image to 
the selected area. The layout window will automatically reflect the new 
image size, outlined in dashed lines. If you are not satisfied with your 
cropped area, you can drag or resize the cropped area to reposition the 
crop. You may also select the Restore button to undo the crop. The origi-
nal image will display, and you may crop the image again. Selecting the 
Close button will close the Display window and finalize your crop. If you 
decide not to crop the image, Restore the image and Close the window.

You may crop a file with multiple pages. You may choose to crop each 
page separately, or you may crop each page in the same way. To crop all 
pages in a file at once, select the first page of the file and then Crop. You 
will be asked, “Make same change to all pages in job?” If you click Yes, 
all pages will be cropped. If you click No, only the currently selected page 
will be affected.

Unless you restore the full image, the image will be cropped when it is 
printed. Cropping does not alter the original file. All cropping informa-
tion is stored in the internal structures of the layout. The crop remains 
in effect as long as the layout remains in effect. The only way to save 
cropping information is to write a CLF file. If you want to send a cropped 
image to the spooler, you must crop the image on the screen, select the 
Write CLF button in the File Information dialog to write a CLF file, and 
then send the CLF file to the spooled queue. 
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Crop to Size
The second button at the lower left corner of the Display window is the 
Crop to Size button. Clicking this button once will open the Crop Box 
Size dialog. This dialog allows you to enter the exact dimensions of your 
cropped area. You may also enter the exact coordinates of the top left 
corner of the crop box.

Figure 2.12. The Crop Box Size dialog. This dialog is opened by clicking the Crop to 
Size button in the Display window.

If you have already cropped your image and then click Crop to Size, the 
dimensions and placement values of your current crop will be shown, 
and may be changed.  If the image is not cropped, the full size of the 
image is entered in the size width and height.

Tiling
Images may be tiled through the Display window. When you display an 
image, you will see a Tile button (the third button from the bottom left 
corner of the Display window) after the two cropping buttons (Crop 
and Crop to Size). Clicking the Tile button once changes the display to 
tiling mode. The buttons in the bottom center of the window change 
from Close and Restore to Save and Cancel, red dashed lines divide the 
image into tiles, and red tile numbers appear in each tile. The initial 
placement of the tile lines and numbers depends on the settings in the 
Tiling Options dialog. Use the Cancel button to cancel tiling without 
closing the Display window, and click Save to save tiling without clos-
ing the Display window.
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Figure 2.13. A tiled image in the Display window.

Tiles may be adjusted three ways—manually, through the Change Tiles 
dialog, and through the Tiling Options dialog. ColorBurst will not al-
low you to create tiles larger than the Layout Area or smaller than the 
Minimum Tile Size set in the Tiling Options dialog. If you stretch a row or 
column and an adjacent row or column becomes smaller than the mini-
mum size, it is eliminated. The eliminated row or tile can be recovered by 
making the stretched row or column smaller again.

When adjusting tiles manually, there are several options available. Placing 
the arrow over a red dashed line changes the arrow to the resize arrow; 
click the mouse and move the line to stretch the column or row of tiles. 
Click the right mouse button over a tile to move that row of tiles. Click 
the left mouse button over a tile to move that column of tiles.

Change Tiles
Once you are in tiling mode, if you click the Tile button a second time, the 
Change Tiles dialog will open. This box allows you to enter the number 
of tile columns and rows, as well as resize each individual tile and specify 
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which tiles to print. The current number of columns and rows appears 
when you open the box; the calculated size of the tiles resulting from 
these numbers appears below in the entry boxes. This dialog is also avail-
able from the Scaling, Rotation, & Tiling dialog, by clicking the Tile button.

There are three ways to constrain tile sizes. If you select Keep columns in 
row/rows in column the same, all of the tiles within a column will be the 
same width, and each tile in the same row will be the same height. You 
may also choose to keep only one of these dimensions the same, allowing 
you to create staggered tiles of different sizes within each row or column.

The Select Tiles to print group allows you to print specific tiles. Each tile 
is numbered according to the Print Rows or Print columns setting in the 
Tiling Options dialog. Each tile that will print is numbered in the Display 
window. The default is to print all tiles, so all tiles will display with a 
number when a file is tiled. When any other range is entered, only the 
selected tiles will display with tile numbers, and only those tiles will print.

Figure 2.14. The Change Tiles dialog. This dialog is opened by clicking the Tile button 
in the tiling mode of the Display window.

Clicking the Reset button will restore the Tile Size set in the Tiling 
Options dialog. Click the Undo Tiling and then Save to remove all tiling 
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from the image. Clicking Save will close the Change Tiles dialog and 
divide the image into equal tiles according to the numbers entered in the 
Columns and Rows boxes. Clicking Cancel closes the Change Tiles dialog 
without making any tiling changes.

Once the Change Tiles dialog is closed, to save your tiling information, 
select the Save button. The buttons at the center will change back to 
Close and Restore; click the Close button to close the tiled image.

When tiling is saved and the Display window is closed, the box in the 
layout window representing the image will change to represent only the 
first tile of the image. If you print the first tile, the printer will advance 
and print each succeeding tile until all tiles are printed. Tiles can be 
printed in order of rows or columns, as set in the Tiling Options dialog.

Unless you Cancel the tiling information, the image will be tiled when 
it is printed. Tiling does not alter the original file. All tiling information 
is stored in the internal structures of the layout. The tiling information 
remains in effect as long as the layout remains in effect. The only way to 
save tiling information is to write a CLF file. If you want to send a tiled 
image to the spooler, you must tile the image on the screen, select the 
Write CLF button in the File Information dialog to write a CLF file, and 
then send the CLF file to the spooled queue. 

If you want to tile an image that is scaled, rotated, and/or cropped, it is 
a good idea to make those changes before tiling the image. If the tile 
size is set to a specific size in the Tiling Options dialog, making the image 
larger (by scaling or changing its crop) may result in more tiles. Making a 
file smaller may result in fewer tiles. If you set a number of columns and 
rows in the Change Tiles dialog, making the image larger will make each 
tile larger, which may result in tiles that are larger than the layout area. 
Likewise, making the image smaller will make each tile smaller, which 
may result in tiles that are smaller than the minimum size. If this occurs, 
an error message will appear to inform you that tiling will be reset to tile 
by the size set in the Tiling Options dialog. Any changes from scaling, 
rotation, or cropping changes will undo manual tiling.
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You may print multiple copies of each tile by entering the number of 
copies in the Printer Options dialog. The first tile will print as many times 
as specified, then the second, and so on.

Tiles are always printed with cut marks to show where the overlap and 
trim is to be cut so that adjacent tiles abut exactly. These marks are always 
1/4 inch long by one pixel wide and are positioned according to the Tile 
Overlap and Trim Outside Tiles values entered in the Tiling Options dialog.

Scale&Rotate 
The Scaling, Rotation, and Tiling dialog can be opened by choosing 
Scale&Rotate from the File menu, by clicking the Scale&Rot button in the 
File Information window, or by clicking the fourth button from the bottom 
left corner of the Display window. Scale&Rotate will be disabled in the File 
menu if no files are open. The Scaling, Rotation, and Tiling dialog contains 
three tabbed windows; it opens in the Scale, Rotate, Tile tab.

General tab

The first tab from the left, General, shows the currently selected file’s 
name and information. The Unit of Measure, used for layout and file 
dimensions and in the Display window, may also be changed here.

Figure 2.15. The General tab of the Scaling, Rotation, and Tiling dialog.
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Scale, Rotate, Tile tab

The Scale, Rotate, and Tile tab provides several options for scaling im-
ages, including a scaling method specific to tiling. You may also rotate 
files and access the Change Tiles dialog.

Figure 2.16. The Scale, Rotate, Tile tab of the Scaling, Rotation, and Tiling dialog.

The first way to scale an image is Scale by percentage. A number 
entered here changes the image size to a percentage of the original 
size. Therefore, numbers less than 100 make the image smaller, while 
numbers greater than 100 enlarge the image. The default is 100%, the 
original size of the image. The Height box is enabled when the Scale 
width and height independently checkbox is selected; this allows for 
each dimension to be scaled to a different percentage.

The second way to scale an image is by a user-defined width or height. 
When a number is entered in either the Scale to width or Scale to height 
entry box, the other dimension will automatically change to keep the 
proportions of the original file, unless the Scale width and height inde-
pendently checkbox is selected. You may enter the width or height in 
printers points, picas and points (p), inches (i), feet (f), millimeters (mm), 
centimeters (c), meters (m), or pixels (x). The default unit can be selected 
in the Units of Measure pop-up menu (located in the General tab).
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The Scale width and height independently checkbox allows for anamor-
phic scaling. When this box is selected, you may scale the width and 
height without affecting the other dimension. When this box is un-
checked after scaling a file, the original ratio is used based on the value 
in the Width box.

Scale to Layout Size
A third method of scaling is by the width or height of the layout size. 
Selecting either the To Width or To Height button in the Scale to Layout 
Size group changes the width or height of the selected image to the 
width or height of the layout size. Once one of these buttons is se-
lected, the dimension and percentage values in the dialog will change 
automatically.

Scale to Tile Size
The Scale to Tile Size group makes tiling a scaled image easy. Set the tile 
size in the Tiling Options dialog. Enter the number of tiles you want to 
print in the Number of tiles box. Select the To Width button to scale the 
image so that there are that number of tiles at the set width across, or 
the To Height button to scale the image so that there are that number of 
tiles at the set height down. The dimensions will automatically change in 
the Scale to width and Scale to height boxes. The total number of tiles 
(across and down) is shown below the To Height button.

Reset Scaling
To undo scaling and return to the original image size, select the Reset 
Scaling button.

Rotation
You can rotate a file by selecting one of the four file 
orientation symbols in the Rotation group, shown right. 
An image may be rotated in 90° increments. The “T” 
shape in the 4 boxes indicates the top of the file. By default, the upper 
left symbol will be highlighted, which means the top of the file is up, and 
the image has not been rotated from its original orientation. The upper 
right symbol will rotate the image 180° from its original orientation, 
making it appear upside down. The lower left symbol, when selected, 
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will rotate the image 90° to the left, and the lower right symbol will 
rotate the image 90° to the right of the original orientation.

You may scale and/or rotate a file with multiple pages. You may choose 
to alter each page separately, or you may alter each page in the same 
way. To scale or rotate all pages in a file at once, select the first page of 
the file and then scale or rotate. You will be asked, “Make same change 
to all pages in job?” If you click Yes, all pages will be changed. If you 
click No, only the currently selected page will be affected.

You can change the size of tiles without having to display an image by 
clicking the Tile button. This button will open the Change Tiles dialog, 
which allows you to enter tile size values directly. You may also remove 
tiling from the image entirely.

PostScript Only tab

The PostScript Only tab can be used to change the page size of a 
PostScript file. When a PostScript job is opened, its size is determined 
from its header. Often, however, this size is incorrect, usually because 
the software that created the file assumed a specific paper size that was 
too small to fit the full image. This results in showing just the lower left 
portion of the image or even a completely empty image where no part 
of the job falls inside the page window. 

To change the page size, enter a new page width and height. The image 
itself does not change; only the window enclosing the image changes to 
the new size. The scaling factor is not affected. The box representing the 
image in the layout window changes to reflect page size changes, and 
the layout is refit. Use the Reset Size button to revert back to the file’s 
original dimensions.
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Figure 2.17. The Postscript Only tab of the Scaling, Rotation, and Tiling dialog.

Select the OK button to finalize your selections and close the Scaling, 
Rotation, and Tiling dialog. When the window is closed, the layout will 
reflect any changes you made. A scaled image will appear at its new size 
with its name in red type. A rotated image will appear at its new ori-
entation; the name of the file is rotated as well to indicate the angle of 
rotation. If you display a rotated image, the display will show the image 
rotated. You may select a scaled and/or rotated image and scale and/or 
rotate the image again. If you restore a scaled image back to its original 
size (100%) and select the OK button, the layout will show the image at 
its original size, and the name will go back to blue type.

NOTE:	 When an image is scaled or rotated, a general refit takes 
place. Refit repositions all images using the current best fit 
formula. Any repositioning using the mouse will be lost.
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3

Printer Setup Menu

The second menu item is Printer Setup. This menu is used to save and 
restore ColorBurst settings as a Printer Setup file, also known as a 
ColorBurst “environment”. The name of the Printer Setup file (.env file) 
currently in use is displayed in the menu bar after the Help menu.

Figure 3.1. The Printer Setup menu is used to load and save Printer Setup files, also 
known as ColorBurst "environments."

A Printer Setup file contains ColorBurst settings from all of the Options 
menu dialogs that take effect without restarting ColorBurst. When 
ColorBurst is installed, a folder named “ENV” (short for “environment”) 
is created in the ColorBurst folder that contains printer setup files 
(named *.env) for different printers, inks, and media. Printer Setup files 
not only make using ColorBurst extremely convenient, they are the most 
important part of multi-queue spooling. They tell the spooler how to 
handle the files in a particular queue during spooling.

Load
Selecting Load under the Printer Setup menu opens a standard Open 
dialog, with the default path as the ColorBurst ENV folder. After choos-
ing a file, a message will appear asking you if you are sure you want 
to restore the ColorBurst environment. Restoring a Printer Setup file 
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restores the options saved in the Printer Setup file, and you will lose 
the current settings. The name of the newly restored printer setup file 
appears in the menu bar. The Message window also states that the file 
was restored.

Figure 3.2. The Open dialog appears when you select Printer Setup > Load.

Save and Save As
Selecting Save will save your ColorBurst settings by overwriting your 
current ENV file. Choosing Save As will open a Save As dialog. Saving a 
printer setup file saves all current settings in all Options dialogs that take 
effect without restarting ColorBurst in an ENV file. 

Your custom Printer Setup file may be restored at a later time, and may 
be used by the Spooler. Each spool queue can use a different Printer 
Setup file. All files in a queue will be processed using the settings in 
the Printer Setup file specified. For more information on Spooling, see 
Chapter 5: Spooler Menu.
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4

Options Menu

The third menu item is Options. All of these selections open dialogs that 
establish the working environment for ColorBurst.

Figure 4.1. The ColorBurst Options menu.

Printer Options
The first selection in the Options menu is Printer Options. Selecting this 
will display the Printer Options dialog.

Before describing the contents of this dialog, a brief description of the 
layout feature is necessary. A layout is in effect when the layout win-
dow is displayed on-screen. This window emulates the media that the 
selected printer uses. The layout window is proportional to that media; 
the layout window title bar displays the dimensions of the media and a 
dashed line shows the printable image within that media. The dimen-



34 · Options Menu	 Layout Series

sions displayed in the title bar are in the units selected in the Units of 
Measure group.

General tab

The Printer Options dialog opens in the General tab. This tab contains 
important settings for your printer including printer type, layout size, 
and resolution.

Figure 4.2. The General tab of the Printer Options dialog.

Printer and Port
The Printer and Port group allows you to select your printer model 
and choose the printer port that your printer is attached to. When you 
choose ENCAD, HP Series, Epson, Mimaki, or Roland in the Printer pull-
down, you can click the Setup button to open a Printer Setup dialog box. 
The other printers do not have special setups. Each Printer Setup is de-
scribed in detail below. In the ProLab version of ColorBurst, the LightJet 
and Lambda are also available.
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Printer Port
The Printer Port pulldown menu allows you to select an output port for 
your printer. You will see LPT1, LPT2, LPT3 and None in the pulldown list, 
as well as any defined NT print queues. Choose the port that your printer 
is physically attached to. You may select None if you are saving files only 
and do not intend to send data to a printer. See Write to RTL file for 
more information on saving RTL files using the None port.

ENCAD Printer Setup
To set ENCAD options, choose ENCAD in the Printer pop-up menu and 
click the Setup button. The ENCAD Printer Setup dialog will open.

Figure 4.3. The ENCAD Printer Setup dialog.

The ENCAD Printer Model pop-up menu lets you specify how many inks 
your printer supports. When using a four-color printer, select CMYK only 
printers in the pop-up menu. When you select 850C and similar in the 
pop-up menu, the ENCAD 850C only group becomes active to allow 
you to specify which cartridges will be used. Selecting 4 inks will make 
the Ink cartridge sets pop-up menu active, allowing you to choose the 
left, right or both sets of cartridges to use for printing. 

When you print to a ENCAD, the paper will not automatically cut after 
printing unless you select the Turn on automatic cut feature checkbox. 

The Bidirectional printing checkbox turns bidirectional printing on and 
off. Normally the printhead prints while moving in one direction, then 
moves back to the starting point to print the next pass. Bidirectional 
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printing will put ink down while the printhead moves in both directions. 
This results in faster printing with a slightly lower print quality.

Epson Printer Setup
When you choose Epson in the Printer pop-up menu and click the Setup 
button, the Epson Printer Setup dialog opens, allowing you to set spe-
cific Epson settings.

Figure 4.4. The Epson Printer Setup dialog.

The Epson Printer Type pop-up menu tells ColorBurst which type of 
Epson printer you are using so it can communicate with the printer 
correctly. The printer selected in this pop-up menu determines which 
choices are available in the rest of this dialog.

The Printer Resolution pop-up menu shows the available printer reso-
lutions for the printer type you have selected. For printers that allow 
variable dot printing, you will see variable dot resolutions listed as well 
as single dot resolutions (standard). When a variable dot resolution is 
chosen, the printer will use ink droplets of different sizes. Variable dot 
increases print quality.
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The Printer Dot Size pop-up menu shows all dot size options available for 
the printer and resolution you have chosen. The dot size will affect print 
quality—the smaller the dot, the finer the print.

If Epson’s Microweave is available for the selected printer, you will see 
the valid choices listed in the Microweave pop-up menu. If Microweave 
is not available, you will have only one option, “Off.”

Depending on the printer you have selected in the Epson Printer Type 
menu, you will see a list of available color modes. Choose the number 
of inks that you want your printer to use. When 6 color (or higher) is 
chosen in the Number of Installed Inks menu, the Light Ink Curves in the 
Color Adjustments dialog will be activated.

The Use bidirectional printing checkbox turns bidirectional printing on 
and off. Normally the printhead prints while moving in one direction, 
then moves back to the starting point to print the next pass. Bidirectional 
printing will put ink down while the printhead moves in both directions.

The Cut Media checkbox tells the printer to cut after printing is com-
pleted. This setting overrides any settings on the control panel of the 
Epson printer.

HP Printer Setup
When you choose HP Series in the Printer pop-up menu and click the 
Setup button, the HP Printer Setup dialog opens. This is where you can 
set specific HP settings.

The HP Printer Type pop-up menu is important if you select Use special 
print method, which enables the Special Print Only group. ColorBurst 
needs to know which HP printer you are using so it can properly com-
municate with the printer when using the options in the Special Print 
Only group.

When you print to the HP, the paper will automatically cut after printing 
unless you select the Inhibit automatic cut checkbox.
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Figure 4.5. The HP Printer Setup dialog.

Selecting the Double Horizontal Resolution checkbox will double the 
ColorBurst print resolution. The maximum resolution you may en-
ter in the DPI box in the Printer Options dialog is 720 dpi. Use the 
Double Horizontal Resolution checkbox to print at 1440x720 enhanced 
resolution.

Selecting Use Special Print Method gives you access to the Special Print 
Only group. The Use bidirectional printing checkbox turns bidirectional 
printing on and off. Normally the printhead prints while moving in one 
direction, then moves back to the starting point to print the next pass. 
Bidirectional printing will put ink down while the printhead moves in 
both directions. 

Selecting UV inks will decrease print speed, which is necessary for UV 
inks—you must select this option when using UV inks to maintain print 
quality.

The Number of print passes box allows you to set the number of passes 
through ColorBurst. However, if you plan on using 8 pass or 6 pass, it 
is recommended to use the front panel on the HP to set your number 
of passes.

8 pass	 select Best (2000 series) or Photo (3000 series) on 
the front panel of the HP; prints 18 square feet/hour
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6 pass	 select Normal (2000 series) or Productivity (3000 
series) on the front panel of the HP; prints 28 square 
feet/hour

4 pass	 42 square feet per hour (recommended for photo 
gloss and semi-gloss)

2 pass	 2 square feet per hour (designed for heavy bond)
The Shorten advance (micro units) box allows you to physically shorten 
the printhead advance. This is useful when you are getting banding 
in your output and you are sure all of your jets are firing. To test your 
printhead, go to the front panel of your HP and press the Enter button. 
Scroll to Utilities, select Service tests, then select Image quality print. 
The HP will print a test pattern that will show you if all of your jets are 
firing properly. If they are and you are getting banding, enter a positive 
number in the Shorten Advance box to shorten the advance, or a nega-
tive number to enlarge the advance. The recommended number is 3; 
requiring a value over 5 indicates a printer problem.

Roland Printer Setup
When you choose Roland in the Printer pop-up menu and click the 
Setup button, the Roland Printer Setup dialog opens, allowing you to set 
specific Roland settings.

Figure 4.6. The Roland Printer Setup dialog.

The Roland Printer Model pop-up menu lets you specify which Roland 
printer you are using. When the FJ-500/400 is selected, the Model 
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FJ-500/400 only group becomes active. The Print Mode pop-up menu 
allows you to change the resolution and specify whether the printer uses 
a fixed size or variable size dot.

When the FJ-500/400 is selected in the pop-up menu, you may choose 
either 4, 6, or 8 inks used for printing. Selecting 4 enables the Ink type 
buttons, to choose between Dye and Pigment. 

When Other models is selected in the pop-up menu, you may only 
choose printing with 4 or 6 inks. Other Models also activates the Use 
small dot for printing checkbox. Select the Use small dot for printing 
checkbox if you want the Roland to print at 720 dpi. If it is unchecked, 
the Roland will use regular dots, which is 360 dpi.

The Use bidirectional printing checkbox turns bidirectional printing on 
and off. Normally the printhead prints while moving in one direction, 
then moves back to the starting point to print the next pass. Bidirectional 
printing will put ink down while the printhead moves in both directions.

Select the Enable automatic cut after printing checkbox if you want the 
Roland to automatically cut the media after the print is finished.

Mimaki Printer Setup
When you choose Mimaki in the Printer pop-up menu and click the 
Setup button, the Mimaki Printer Setup dialog opens, allowing you to set 
specific Mimaki settings.

Figure 4.7. The Mimaki Printer Setup dialog.
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Select the 6 Color Printing checkbox if you want the Mimaki to print us-
ing six ink cartridges.

The Use bidirectional printing checkbox turns bidirectional printing on 
and off. Normally the printhead prints while moving in one direction, 
then moves back to the starting point to print the next pass. Bidirectional 
printing will put ink down while the printhead moves in both directions.

Select the Automatic cut after print checkbox if you want the Mimaki to 
automatically cut the paper after the print is finished.

Units of Measure
The Units of Measure pop-up menu sets the default unit of measure-
ment used in ColorBurst: Printers points, Picas and Points (p), Inches (i), 
Feet (ft), Millimeters (mm), Centimeters (c), Meters( m), or Pixels (x).

There are two methods in which these values may be entered. The first is 
to select the type of units you are using in the Units of Measure pop-up 
menu, then enter your offset values. The second method is to enter the 
value, then follow it with the letter(s) designating your unit type.  After a 
value has been entered, it will be converted to the unit of measurement 
currently selected in the Units of Measure option box.

Unlike all other units, pixels is not an absolute unit. An offset of 200 pix-
els when printing at 200 dots per inch (dpi) is a one inch offset, but an 
offset of 200 pixels at 300 dpi is only 2/3 inches. Internally, offsets are 
saved as printers points. Whenever you enter an offset in pixels, it is con-
verted to printers points using the current Output Resolution specified in 
the PostScript Interpreter Options dialog. As long as you do not change 
resolutions, you should have no side-effects when offsetting in pixels.

Mirror Image
The Mirror Image checkbox in the Printer Options dialog allows you to 
print an image reversed. That is, the printed image would be correct only 
if you look at its reflection in a mirror. You should use this option when 
printing on transparent material that is to be backlit when displayed.
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Write to RTL File
The Write to RTL checkbox determines whether or not an RTL file is 
saved. RTL files are files written in the internal format needed by the 
printer. Because all color correction and pattern finish have already been 
resolved before the RTL file is written, printing an RTL file is very fast. 
This makes RTL files very useful when printing multiple copies. When you 
specify that multiple copies should be printed, an RTL file is always cre-
ated regardless of the setting of Write to RTL File. After the first copy is 
done, the RTL file is read for all subsequent copies. This should speed up 
printing. If you have not selected Write to RTL File, the RTL file created 
for multiple copies is a temporary file that is deleted after all copies have 
been printed.

RTL files are saved with the extension .RTL. Tiled files saved as RTL files 
create an RTL file for each tile, each with the same name. The extension 
for these files starts with RTL, then R00, R01, etc. through R99.

The Write to RTL File checkbox works with the Printer Port pop-up menu 
to determine where output is directed. If Write to RTL File is selected 
and the printer port selected is None, an RTL file is created in the Output 
Directory set in the PostScript/Layout Output File Options dialog. If both 
an LPT port and the “write” option are selected, then the file is output 
to the printer and written as an RTL file to disk. When a print queue is 
selected, an RTL file is written to the queue and then sent to the printer. 
An RTL file can be copied directly to the printer at a later time for faster 
throughput.

Number of Copies
To print more than one copy of a layout, specify the number of prints 
you want in the Number of Copies edit box. A value of “0” (the default 
value) is equivalent to “1” which gives you one print. The maximum 
number of prints allowed is 50.

If you enter a negative number in the edit box, an error message displays 
and “0” is substituted for the invalid value. If you enter a value greater 
than 50, an error message is displayed and “50” is substituted for the 
invalid value.
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Layout Area and Resolution
The Layout Area and resolution group defines the layout area for the 
current printer. The size of the layout area is represented in the layout 
window and is used in all best-fit formulas for positioning images in a 
layout. Whenever you change the size of the current layout area and 
save the changes, the layout window is automatically updated. If there 
are images in the layout when the layout area size changes, all images 
are refit within the new layout area, which may cause images to no 
longer fit. It is recommended that you change the layout area when the 
layout is empty.

You can set the width and height of the Layout area in the Width and 
Height edit boxes, using the currently defined units of measure or special 
characters to define the units desired. For most printers, you can set the 
resolution of your printer in the Across edit box (see Note below). The 
Across box shows the horizontal resolution. The Down box displays the 
vertical resolution and is for display purposes only; this field can not be 
edited directly. When a value is entered in the Across box, the Down box 
is changed to match the Across value. To set a resolution in which the 
horizontal and vertical resolutions do not match, use the Setup button to 
select a resolution in the Printer Setup window.

NOTE: 	 For several Printer Types, such as Epson and Roland, the 
resolution should not be set using the Across box. To set the 
resolution for these printers, you must click the Setup button 
to open the Printer Setup window for the printer. These print-
ers have preset resolutions in a pop-up menu in their Setup 
window. The pop-up menu settings in the Setup window will 
override any value entered in the Across box. 

Margin Between Images
The Margin Between Images group allows you to specify how much 
white space should be reserved around each image in a layout. There are 
two edit boxes, In and Down, for specifying different amounts of space 
to the left and right of an image and the remaining space above and be-
low an image. Margins are part of the calculation for positioning images 
in the layout. As the margin increases, fewer images will fit in the layout.
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Offset Image in Layout
You may enter offset values through the Offset Image in Layout group. 
“Offset image” refers to a physical shift on the print media. The point 
of origin is established as the top left corner. Therefore, positive values 
will move all images in the current layout to the right and down, while 
negative values will move all images in the current layout left and up. 
Negative values can be entered to move part of the image off the media. 
This is important for centering large images, moving tick marks out of 
view, or eliminating built-in white space in the image.

Current Offsets is a temporary shift for the current job only. After enter-
ing these values, if you decide you would like to make them permanent, 
simply click the Set button. The current offset values will be transferred 
to the permanent offset values.

Permanent Offsets is a permanent shift for all jobs, today, tomorrow, 
next week. If you want to enter values that are different than the Current 
Offsets, simply enter them directly into the designated Permanent 
Offsets boxes. To reset these values to zero (default), simply select the 
Clear button. 

TCP/IP tab

The TCP/IP tab in the Printer Options dialog is used to set an IP address 
when printing over Ethernet.

TCP/IP Printer
The TCP/IP Printer group lets you enter an IP address for your printer, to 
allow for Ethernet printing. The Test button will verify the IP number you 
have entered. When you are finished entering a valid IP number, click OK 
to save your IP address. The IP address will now appear in your Printer 
Port pop-up menu as TCP/IP Printer.
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Figure 4.8. The TCP/IP tab of the Printer Options dialog.

Cut Marks tab

The Cut Marks tab in the Printer Options dialog is used to turn cut marks 
on or off, as well as specify the type of cut marks and their position.

Print Cut Marks
The Print cut marks checkbox determines whether or not cut marks are 
printed around each image in the layout. When this box is selected, 
ColorBurst creates marks to indicate the edge of the image, i.e. where 
to trim the image. The rest of the options in the Cut Marks tab are only 
available when this checkbox is selected.

Specify shape of marks
When the Print cut marks checkbox is selected, there are five different 
cut mark shapes to choose from. Each type is visually represented by 
a diagram to show what the marks will look like. To select a cut mark 
shape, click on the diagram to highlight it. The appropriate options in the 



46 · Options Menu	 Layout Series

Cut Marks tab will become available depending on which shape/diagram 
is selected.

Figure 4.9. The Cut Marks tab of the Printer Options dialog.

For standard crop marks, select the first diagram, Cut Marks. This will 
create an “L”–shaped mark, facing out from the image, in each corner of 
the image. When used with tiling, the Cut mark will print at the overlap 
mark so that when the tiles are cut they will line up with each other 
without overlap. 

The second option is Corner marks. This will print an “L”–shaped mark 
on the corners of the image facing into the image. When Corner marks 
are used with tiling, the marks print on the perimeter of the image, al-
lowing physical overlap when trimmed.

The third option is Circles. This setting will print circles in the corners as 
cut marks instead of L–shaped marks. Circles should be selected when 
using cutters requiring circular cut marks, such as the I–Cut. In addition, 
you can use the settings in the Cut Devices tab to create I–Cut script files 
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(the Cut Devices tab is also in the Printer Options dialog). When Circles 
is selected, make sure to set the Diameter of circle to 0.25" in the Enter 
dimensions group when using the I–Cut.

The last two cut mark shapes create cut or corner marks as well as a 
dashed or solid box drawn around each image. These shapes can be se-
lected when using an automatic cutting device, such as the Fotoba. The 
two entry boxes below the diagrams, Black (on) size and White (off) size, 
determine whether the line is solid or dashed. To draw a solid black box, 
set the Black (on) size to 1 (or any number other than zero) and set the 
White (off) size to zero (0). To draw a solid white box, set the Black (on) 
size to zero and set the White (off) size to any number other than zero. 
To draw a dashed line, give both boxes values other than zero. A value of 
zero in both edit boxes indicates that no cut box will be drawn.

Enter Dimensions
The Enter dimensions group lets you enter the Width and Height of the 
cut marks, if applicable. When Circles is chosen as the cut mark shape, 
the dimensions settings change to Diameter of circle. The default value 
for the cut mark Width and Height and for Diameter of circle is a quarter 
of an inch (0.250i). 

The thickness of cut marks can be changed in the Enter dimensions 
group. Click on the Specify Thickness In Pixels button to choose a width 
of 1, 2, 3, or 4 pixels. If you want a different measure, you may enter it 
manually by selecting the Specify Thickness In Units of Measure button 
and entering the value in the Units entry box. It can be helpful to have 
wider marks when printing at high resolutions, where one pixel-wide 
marks may not be visible.

Position marks
The Position marks group lets you add space between the marks and 
the corners of the image. You can enter a positive number to add space 
around the image, which is useful for pole wraps. The maximum space 
allowed is 72" wide. A negative number will place the mark inside the 
image, for trimming bleed.
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Job Titles tab

The Job Titles tab in the Printer Options dialog is used to specify job 
title options for individual images or entire layouts. A job title is printed 
information describing an image (or layout) that is not intended to be 
part of the final printed product. When titles are turned on, a gray bar 
representing each title will appear in the Layout window.

Figure 4.10. The Job Titles tab of the Printer Options dialog.

Print Job Titles and Title Options
The Print job titles checkbox determines whether job titles are printed. If 
selected, job titles are created and printed, and the rest of the options in 
the Job Titles tab become available.

The file name (or layout name for layout titles) is always part of a job title 
information. When layout titles are printed, the layout name is deter-
mined by the File Name Template in the Layout Options dialog. If no 
other title options are selected, the name is the only information printed.
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Selecting the Include full path of job name checkbox will enable the 
inclusion of the full path used to open the file. If Include full path is not 
selected, the file name without any path is included in the job title.

If you select the Include current time and date checkbox, the current 
time, day of the week, and date will be included. The time and date are 
determined at the time the title is created.

If you select the Include printer setup file name checkbox, the name of 
the Printer Setup file will be included in the job title. The Printer Setup 
file in effect is shown in the main menu bar after the Help menu.

The Include additional comment box allows you to add a comment 
to the job title. Simply type your comment in the comment entry box 
below. You may enter a maximum of 255 characters. Any comment 
entered here will print in all image and layout job titles.

If you select the Uppercase checkbox, the entire title will print using up-
percase letters. Otherwise, all characters except the first letter of the day 
and month name will be printed in lowercase letters.

Nested Layouts
The Nested Layouts group contains settings that determine the type 
of job titles that are printed. There are three choices: print a layout title 
only, print job titles only, or print both layout and job titles. Job titles 
appear above each individual image; a layout title appears at the top of a 
layout (above two or more nested images).

Space Reserved for Titles
The Space reserved for titles group allows you to set the size and spacing 
for titles. When job titles are included, the height of the title is added 
to the height of the image. This means that the job title affects vertical 
positioning and the height of the block in the layout window. Horizontal 
positioning is not affected by whether titles are included because, while 
the title may have enough information to extend past the right edge of 
the image, it is always clipped at the right edge. If the point size or spac-
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ing values are adjusted, the Layout window will be updated to reflect the 
changes after the Printer Options dialog is closed.

You may change the size of the title using the Point size of type in job 
value entry box. The minimum size for titles is 4 points; the maximum 
size is 144 points. 

The Additional vertical space between job title and job entry box allows 
you to adjust the amount of space between the title and job. This can 
allow space to cut the title away from the image. You may add up to 4 
inches of extra space between the title and job.

Cut Devices tab

The Cut Devices tab in the Printer Options dialog has settings that can 
be used when you are using a printer with a built–in cutter or a cutting 
device such as an I–Cut.

Contours
The Contours group is used to find contour cutting data in image files, 
using spot color names to describe the contour. A contour is a vector 
outline of the shape to be cut. Contour shapes can be created in any 
program with vector illustration capabilities that allow you to specify 
a custom spot color as the stroke color, such as Adobe Illustrator or 
CorelDRAW. The contour shape should be an outline with no fill color 
(stroke color only, transparent fill). The stroke color is not actually print-
ed, but it must be a named spot color—ColorBurst uses this spot color 
name to find the contour data. You may name your spot color anything 
you like, such as “contour” or “cut path”—it is only important that the 
name in your file matches the name in ColorBurst’s contour list. The con-
tour names are not case–sensitive, i.e. “cut path” will match “Cut Path” 
and “CUT PATH”. When a contour is found, the contour is cut on the 
center of the stroke line, so you may set the contour path to any weight 
or thickness in your vector illustration program.
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Figure 4.11. The Cut Devices tab of the Printer Options dialog.

The Search Postscript files for named colors that describe contours 
checkbox determines whether files should be searched for contour data. 
If this checkbox is selected, the contour name pop-up menu becomes 
active. Only names that appear in the pop-up menu will be searched for. 
If your contour path stroke color is not a spot color named in the pop-up 
menu, it will not be found.

You may add up to 20 contour spot color names. To add a contour spot 
name, type the contour name in the Specify named colors that describe 
contours box, then click the Add button. The name you entered will be 
added to the pop-up menu. You may change a name by selecting it in 
the list, typing in your changes, and clicking the Edit button. To remove 
a name from the list, select the name in the pop-up menu and click the 
Del button. Please note that changes to the list take effect immediate-
ly—if you click Cancel to close the Printer Options dialog, the names in 
the contour name list will not revert back to the original list.
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The Density group allows you to choose how the contour line is inter-
preted. You may choose from Coarse, Medium, or Fine. Fine is recom-
mended to give the smoothest contour.

I–Cut
The I–Cut group is used to create I–Cut scripts during printing. If the 
Generate I–Cut scripts box is selected, a CUT file used by the I–Cut cut-
ter will be created in the path named in the Path for “CUT” files box. 
You can use the Find button to locate a path to save CUT files in.

CUT files are given the same name as the layout with a .CUT extension 
(layout names are determined by the File Name Template in the Layout 
Options dialog). It is recommended to print layout titles (in the Job Titles 
tab) when creating CUT files. This will make it easier for you to match 
your prints with CUT files, since the layout title name and CUT file name 
are the same.

The Include contour cut commands in I–Cut scripts box determines the 
shape of the cut. If it is not selected, cuts are limited to rectangular 
shapes. If it is selected, any contour data found during processing will 
be included in the CUT file. If searching for contours is not turned on in 
the Contours group (the Search PostScript files for named colors that 
describe contours box is not selected), any contour data in the files will 
be ignored, even if the Include contour cut commands in I–Cut scripts 
box is selected. In other words, both boxes must be selected to include 
contours in I–Cut scripts.

Grids tab

The Grids tab in the Printer Options dialog allows you to set up a uni-
form grid system for automatic image placement in the Layout.

Use Grids
The Use grids checkbox turns ColorBurst’s grid-based layout option on 
and off. When the Use grids checkbox is selected, the other options in 
the Grids tab become available. All of these settings work together to 
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determine grid size, grid placement, and image placement within the 
grid boxes.

Figure 4.12. The Grids tab of the Printer Options dialog.

There are two image placement options when using grids. You can 
either center images inside each grid box or align the image to the upper 
left corner of each grid box.

Figure 4.13. The Layout window with Grids turned on.
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Columns and rows
The Columns and rows settings are used to divide the layout window 
into a grid. Type in the number of columns and rows, and type in a 
width and height.

Margins
The Margins settings allow you to define margins around the grid and 
between the grid boxes.

Scaling and cropping
There are three options available to handle images that are larger than 
the grid box size. The first option is Crop image to fit. This option will 
crop your image without scaling. The crop can be changed through the 
Display window. The second option is Scale image to fit. The image will 
be scaled proportionally to fit inside the grid box. The third option is 
Do not add job to layout. When this option is selected, you will get an 
“image does not fit” message when adding an image that does not fit 
in the grid.

If the image is smaller than the grid window, you can scale it up to fit 
the grid by selecting the checkbox. The pop-up menu can be set to 
Best fit, which will scale the larger dimension to the size of the grid 
box, or to Scale width and height anamorphically, which will scale the 
image to the exact dimensions of the grid box.

NOTE:	 The Layout size, set in the Printer Options General tab, will 
change to match the total dimensions of the grid boxes and 
margins entered in the Grids tab.

Multipage Job Options
The Multipage Job Options dialog lets you specify how to handle files 
that contain more than one page.

Place multiple pages of job in layout
When this option is checked, each page is placed in one layout. If the 
layout is filled, new layouts will be created until all pages are placed in 
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a layout. The Layout window will display the first layout and thumb-
nails will appear at the bottom to indicate subsequent layouts. Click on 
any thumbnail to view the layout, or scroll through layouts using the 
arrow buttons.

Figure 4.14. The Multipage Job Options dialog.

The File Information box will indicate which page of the document 
is currently selected. The first page of a layout is selected by default. 
For example, when you open a document that has 5 pages, the File 
Information box will read, “Page: 1 of 5.” You may select any page by 
clicking on it in the Layout window. Note that when you scroll through 
the layouts, the first page in the layout is selected.

Place each page of job in separate layout
This option tells ColorBurst to put each page in a multipage document in 
its own layout. New layouts will be created for each page in the file. The 
Layout window will display the first layout and thumbnails will appear 
at the bottom to indicate subsequent layouts. Click on any thumbnail to 
view the layout, or scroll through layouts using the arrow buttons.

Page Range
This group is active only when a multipage document is open. When 
you change the page range, the layout(s) will be updated immediately. 
You can change the page range as many times as you wish, including 
excluding pages and then adding them into the range again. To delete 
the entire file (all pages) click the Delete All button.
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Layout Options
The next item in the Options menu is Layout Options, which opens the 
Layout Options dialog. These settings will change the layout environ-
ment. Among other options, you can choose the best-fit formula to use 
and specify the procedure to use on size discrepancy errors.

Direct to Printer
The Direct to printer checkbox allows you to specify whether layouts 
containing more than one file should be sent directly to the printer 
or whether intermediate RTL, TIFF, or CT files should be created. This 
checkbox is ignored when a layout contains only a single file. This is 
similar to choosing to create intermediate files from PostScript. There is 
a major difference between PostScript files and layouts, however. With 
PostScript files, there is no way to determine in advance how long the 
interpretation will take. Intermediate files are recommended to eliminate 
that variable. For layouts, all files included in the layout are in a raster 
form before printing begins. It is recommended that Direct to printer be 
selected so that intermediate files are not created.

Figure 4.15. The Layout Options dialog.

When Direct to printer is not selected, output for the layout uses the set-
tings established in the Postscript/Layout Output File Options dialog. For 
example, turning off Direct to printer and setting Create Scitex CT file 
and Save File Only, No Print in the Postscript/Layout Output File Options 
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dialog, will create a permanent CT file that is not immediately printed. If 
job titles are in effect, they will be seen when the CT file is printed.

Delete All Intermediate Files
The Delete all intermediate files checkbox specifies that all PostScript 
files that are rasterized before printing should be created as temporary 
intermediate RTL files. When this checkbox is not set, options in the 
Postscript/Layout Output File Options dialog determine how PostScript 
files should be handled. This checkbox is only considered when there is 
more than one file in the layout being printed. When a single PostScript 
file is printed, the Postscript/Layout Output File Options dialog always 
determines whether intermediate files are created and, if so, whether 
they should be temporary or permanent.

This checkbox is very important when the Direct to printer checkbox 
above it is not selected. In this case, output options for the layout are 
determined from the Postscript/Layout Output File Options dialog. The 
Delete all intermediate files checkbox allows you to specify different 
procedures for processing the layout from processing the PostScript files 
included in the layout.

The Delete all intermediate files checkbox overrides options set in the 
Postscript/Layout Output File Options dialog. Even if you do not set this 
checkbox, if Output directly to printer is selected in the Postscript/Layout 
Output File Options dialog, temporary intermediate RTL files are created 
from PostScript files. If Save File Only, No Print is selected, permanent 
intermediate files are created, but printing of the layout is not inhibited.

Error if Image Too Big
Selecting the Error if image too big checkbox will make sure that any 
image that will not fit in the image area is not added to the layout. The 
error message “Image will not fit on media,” followed by the file name, 
will appear, and the file will not be added to the layout.

This option is most helpful in Spooler mode when layouts are in effect. If 
selected, any file found in the monitored queue that oversets the layout 
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will not be printed; instead it will be moved to the Error queue. This 
ensures that none of your spooled images will be truncated.

If this box is not selected, files that are too large to fit in the image area 
will be added to the layout if one of the following conditions is met:

the image is the only image in layout,
the image touches the left margin and oversets the width only, or
the image touches the top margin and oversets the height only. 

Use Precise Positioning of RTLs in Layout 
This option is helpful when using Step & Repeat with RTL files. If it is not 
selected, there may be some white space between the RTL files in the 
layout. When selected, ColorBurst will pack the pixels next to each other 
for perfect placement. In doing so, the layout will take a little longer to 
begin printing, so it is recommended to only use this option when the 
layout contains multiple RTL files and perfect placement is a concern. 

Layout File Name Template 
The File name template edit box in the Layout Options dialog allows you 
to specify the name of an output file which will be created when more 
than one image is processed into an output file. An example of a layout 
output file is the RTL file that is created when Write to RTL File in the 
Printer Options dialog is chosen. When you select a spooled printer as 
your printer port, the spooled document name is built from this tem-
plate.  The file name template is also used to name TIFFs and CTs from 
layouts, layout Job Titles, and CUT files.

The File name template edit box here works along with the File name 
template edit box in the PostScript/Layout Output File Options dialog. 
When creating a file from a layout, the filename will be created from the 
information in this template, and will then be appended by the informa-
tion in the PostScript/Layout Output File Options template.

Previous to the template, the output name was always LAYOUT. That 
is, the RTL of a layout was always LAYOUT.RTL. To avoid constantly 
overwriting the same file name, the name changed to a unique name, 

•
•
•
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LAYOUT.R00, LAYOUT.R01, etc. There were two problems with this file 
name selection: the file names were not descriptive, and the R00, R01, 
etc. files would not automatically show up in the list of illustration files 
to process. The template now allows you to specify your own name of 
layouts. If you choose not to specify a template, the old name, LAYOUT, 
is still the default selection.

The template can be an exact name of the output file such as XYZ. The 
problem with an exact name like this is that, like LAYOUT, all output 
file names will be the same. Furthermore, unless the name is exactly 
LAYOUT, extensions R00, R01, etc. will not be automatically created. 
That means that each new output file will overwrite the old one.

To allow you to specify different names using the same template, you 
can place one or more special codes in the template. Each special code 
consists of a percent sign (%) followed by a character. Any character in 
the template name which is not preceded by a percent sign is passed 
along as part of the output name. Special codes are replaced by informa-
tion associated with the code. A common special code is %F which is 
replaced by the name of the first file that was entered in the layout. For 
example, suppose there are three images in a layout (ABC.EPS, DEF.TIF, 
and GHI.CT, entered in that order). Using the template %F with no other 
characters will create the output file named ABC. Using the template 
CSE_%F_X creates the output name CSE_ABC_X. Likewise, %L chooses 
the name of the last image that was added to the layout as its output 
name. In the previous example, the output name would be CSE_GHI_X. 
You can also have the output name include the time of day, the date, 
and three unique numbers (000 through 999) to better describe the file 
while also ensuring that one file does not overwrite the next.

Path names in the template are ignored. In most cases the output path 
is that specified in Output Directory in the PostScript/Layout Output 
File Options dialog. The template is searched for path separators (colon, 
backslash, and forward slash), and, if found, all characters up to the last 
separator are ignored. 
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An extension can be specified in the template, including names with 
special codes in them. In most cases, however, the output file type has 
a defined extension which will overwrite any extension that you specify. 
For example, if the output file is to be an RTL and your template builds 
the file name ABC.XXX, the name of the RTL file will become ABC.RTL. 
One exception to this is the name of the document displayed when your 
output file is sent to a spooled printer. That name has no predefined 
extension, so any extension that you enter will be passed along as the 
document name listed in the printer’s window.

If the File name template is left empty, the default template will be 
LAYOUT. This is the name given to all output files prior to templates. 
This is the only template name that will automatically create different 
extensions to try to create unique file names. That is, RTL, R00, R01, 
…, TIF, T00, T01, …, etc. will only be created when the template name 
is LAYOUT.

Special codes begin with a percent sign (%) and are followed by a single 
character. Letters are case independent, that is f and F are identical. All 
defined special codes are replaced by other known information. Any 
character that follows a percent sign but is not defined below is ignored. 
Special codes are grouped into types below. An alphabetical list is in-
cluded after the types.

The following section lists special codes which are replaced by file names 
or affect file names in order to try to make them unique.

Names
Output file names can include the names of images in the layout and 
can be incremented automatically.

%F	 First name. This code is replaced by the first name 
of the first image that was added to the layout. The 
first name includes all characters up to a “dot” that 
separates the file name from its extension.
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%L	 Last name. This code is replaced by the first name 
of the last image that was added to the layout. The 
first name includes all characters up to a “dot” that 
separates the file name from its extension.

%E	 End name at character. This code can be used more 
than once to specify characters in the %F and %L 
names where the output name should end. Each %E 
should be followed by one and only one additional 
character. If the character following %E is then found 
in the file name, the name is ended at that charac-
ter, not including that character. If more than one 
end code is desired, each should be included in the 
template preceded by %E. If the character follow-
ing %E is a letter, that letter is case independent. 
An example might be that you use long file names 
with lots of spaces in the name. You could shorten 
the output name by truncating the name at the first 
space. Do this by specifying the special code %E 
followed by a space character. Using this code, a file 
named “Sunshine over L.A. on a smoggy day” would 
create the output file named “Sunshine.” This code is 
only useful if you use %F and/or %L in the template.

%U	 Increment up. This code tries to ensure unique 
output names by replacing the special code with a 
three digit number between 000 and 999. Each time 
a number is used, it is automatically incremented. For 
example, the template CSE_%U creates output files 
named CSE_000, CSE_001, CSE_002, etc. The first 
number to be used is the number set in the Auto-
increment starting number edit box in the Layout 
Options dialog. The number returns to 000 after 
incrementing past 999. You can set Auto-increment 
starting number to any starting number.
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Dates
Output file names can include the current date or parts of the date.

%D	 Date. This code is replaced by the current date in a 
YYMMDD format. Example: cb%d on July 4, 1997 
becomes cb970704. The order is chosen to ensure 
that the last file created will be listed last alphabeti-
cally. You can place the date in a different order by 
using the individual parts of the date listed below.

%A	 Date. This is replaced by a two digit code holding 
the date of the month. The two digit code will be in 
the range 01 to 31. Example: cb%a on July 4, 1997 
becomes cb04. This will usually be combined with 
other date special codes to build a date in the order 
that you desire.

%M	 Month. This is replaced by a two digit code holding 
the number of the current month. January = 01 and 
December = 12. Example: cb%m%a on July 4, 1997 
becomes cb0704.

%Y	 Year. This is replaced by the last two digits of the 
year. Example: cb%m%a%y on July 4, 1997 be-
comes cb070497.

%W	 Day of the week. This is replaced by the first 
two letters of the day of the week. Sunday = 
su, Monday = mo, etc. Example: cb%w on a 
Wednesday becomes cbwe.

Time
Output file names can include the current time, that is the time when 
writing the output file begins.
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%T	 Time. This is replaced by a six digit code holding the 
current time as HHMMSS using a 24 hour clock. 
Example: cb%t at 4:32:23 PM becomes cb163223.

%H	 Hour. This is replaced by a two digit code holding the 
current hour using a 24 hour clock. The replacement 
will be in the range 00 (midnight) to 23 (11 PM). 
Example: cb%h at 5:21 PM becomes cb17.

%I	 Minutes. This is replaced by a two digit code holding 
the minutes past the hour of the current time. All val-
ues will be between 00 and 59. Example: cb%h%i at 
5:21 PM becomes cb1721.

	
%S	 Seconds. This is replaced by a two digit code hold-

ing the seconds past the minute of the current time. 
All values will be between 00 and 59. Example: 
cb%h%i%s at 5:21:34 PM becomes cb172134.

Miscellaneous
Other codes not fitting the types listed above.

%%	 (%). This specifies that the percent sign is needed 
as part of the output file name. That is, the percent 
sign starting a special code should be ignored and 
the character following is needed. Example: xyz%%. 
becomes xyz%.

Alphabetical list
All special codes are listed alphabetically:

%%	 Percent sign. Miscellaneous code.
%A	 Date of the month. Dates code.
%D	 Date. Dates code.
%E	 End name at character. File Names code.
%F	 First file. File Names code. 
%H	 Hour. Time code.
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%I	 Minutes. Time code.
%L	 Last file. File Names code.
%M	 Month. Dates code.
%S	 Seconds. Time code.
%T	 Time. Time code.
%U	 Auto-incrementing number. File Names code.
%W	 Day of the week. Dates code.
%Y	 Year. Dates code.

Auto-Position Options
The Auto-Position Options group allows you to select the best-fit for-
mula to use when positioning images in a layout. The Refit button allows 
you to refit all images according to one of the best-fit formulas without 
establishing that formula permanently.

There are three best-fit formulas to choose from. Only one can be cho-
sen at a time. They are:

Order Entered
Largest First
Smallest First 

Each formula is further defined by whether images should be placed 
using a top-to-bottom or bottom-to-top arrangement. Select one of the 
following:

Top To Bottom
Bottom To Top 

Images are placed in the smallest unused area in the layout where they 
will fit. As long as there is space, images are placed to the right of previ-
ous images. When there is no more space to the right, new images are 
positioned below previous images when using a top-to-bottom arrange-
ment, and above previous images using a bottom-to-top arrangement. 
Even though the bottom-to-top arrangement places images at the bot-
tom of the media, once all images have been positioned, they are shifted 

•
•
•

•
•
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to the top of the layout. That is, unless you set a vertical offset, images 
will start from the top of the layout.

If an image does not fit in the layout, it is not added to the layout. Be 
aware, however, that even though it is not shown in the layout, that im-
age is still the currently selected file. From the File menu, you can Display 
the image that does not fit, but if you Print the layout, the image will not 
be included. Depending on the formula used, an image that does not 
fit is not necessarily the image that you are adding to the layout. Later 
in this section, see the explanation of the Largest First formula for more 
information.

The default formula is Order Entered because it has no “side effects.” 
Once an image is positioned, it is not repositioned unless you choose to 
refit all images or a general “Refit” command is issued. “Refit” com-
mands are issued when you turn job titles on or off, or when you change 
the layout area while a layout is in effect. If you want to manually 
position image with the mouse, you should use this selection. The only 
image that may not fit in the layout is the image that you are currently 
adding to the layout.

The Largest First formula usually provides the best fit. When you add 
an image to the layout, every image is ordered from largest to smallest 
(largest means the largest area, i.e. width times height). The layout is 
cleared and each image, largest to smallest, is re-added. This does have 
some side effects that you may find unpleasant. Be aware that an image 
that does not fit in the layout is not necessarily the most recently-added 
image. An error message informs you of the name of the file that will 
not fit. If you select Cancel, the layout will return to its previous positions 
and the current image will not be added to the layout. More than one 
previous image may not fit when an image is added. Each image that 
does not fit will produce an error message. You can Cancel at any time 
to restore previous positions, but be aware that once you have accepted 
an image for deletion, it will not be restored by a later cancellation. That 
is, if you select OK for the first image to be deleted but then Cancel the 
second, the first image will be lost and a “hole” appears where it used 
to be. Another side effect is that because all images are repositioned 
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from scratch, any manual repositioning that you might have made with 
the mouse is lost each time a new file is added.

The Smallest First formula is exactly like Largest First, but in reverse. All 
illustrations are ordered from smallest to largest. This has the same side 
effects as Largest First.

Refit Button
The Refit button repositions all image in the layout according to the best-
fit formula currently defined in the Auto-Position Options group. The 
formula selected is not necessarily the current formula, however. Until 
you save  your selections, the current best-fit formula does not change. 
You can use the Refit button to see how other formulas affect the layout 
without making that formula permanent. 

On Size Discrepancy
The On Size Discrepancy pop-up menu determines how size discrepancy 
errors will be handled. First, a definition of “size discrepancy” errors.

When a TIFF, CT, or other raster format is added to the layout, its size is 
absolutely known. When a PostScript file is added, however, the size is 
calculated from information in its header. This may be incorrect because 
PostScript commands may force different sizes. Examples are commands 
that select a particular paper size and commands that set up a different 
orientation. The only way for ColorBurst to know that actual size would 
be to send it to the PostScript interpreter. When adding an image to the 
layout, that would be too time-consuming.

If a layout contains more than one image, its PostScript files are raster-
ized into intermediate files before printing. The actual size of the inter-
mediate file is compared to the size calculated from the header. If the 
actual size is larger than the calculated size by the values in the Margin 
Between Images group, the image might potentially overlap another 
illustration in the layout. This is called a “Size discrepancy error,” and the 
procedure for handling the error is defined in On Size Discrepancy. The 
five defined procedures are:
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Refit images/Delete
Refit/No Delete
Delete image
Stop print
Do nothing 

First, the message, “Size discrepancy error!” is added to the message 
window. Then the image causing the error is checked to see if it really 
overlaps another image. If it does not, the message, “No Action taken” 
is added to the message window and processing continues.

If the size discrepancy does cause an overlap, one of the five procedures 
will be executed. The default action is Refit images/Delete. This issues 
a general refit command to reposition all images. If the refit success-
fully repositions all images, the message “No Action taken” is added to 
the message window. If any image in the layout does not fit, the image 
causing the error is deleted from the layout, and all other images are 
repositioned again. The message is “Deleting image from layout.”

If Refit/No Delete is the defined action, a general refit command is 
issued, but if an image does not fit, no action is taken. Any overlap is 
printed. The message is “No action taken.”

If Delete image is the defined action, the image causing the error is auto-
matically deleted without refitting, leaving a hole where the image was 
supposed to be. The message is “Deleting image from layout.”

If Stop print is the defined action, printing never begins and processing 
is stopped. The message is “Stop print on size discrepancy.” This has 
the same effect as if printing completed its task. The layout window is 
closed.

If Do nothing is selected, any overlap is allowed to print. Images are not 
repositioned. The message is “No action taken.”

1.
2.
3.
4.
5.
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You will probably be able to predict size discrepancy errors according to 
the software package that created the PostScript file. There are ways of 
eliminating size discrepancy errors:

leave extra room in the layout,
print only one illustration,
select Convert from the File menu. 

When all entries in the Layout Options dialog are complete, select the 
Save button or press <Enter>. Selecting the Cancel button or pressing 
<Esc> will cancel all entries you made. Selecting the Help button will 
open ColorBurst’s Help file on the Layout Options dialog.

Postscript/Layout Output
The next Options item is Output Options. Selecting it will display the 
Postscript/Layout Output File Options dialog. These selections are used 
to establish defaults for other commands, such as Print.

Figure 4.16. The PostScript/Layout Output File Options dialog.

Output Options
The Output Options group allows you to create an RTL, TIFF or Scitex CT 
with the Print command (under the File menu). The first option is to have 
the PostScript RIP bitmap Output directly to printer, in which case the 

•
•
•
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Save/Print Options are not applicable. The other options use the Save/
Print Options to determine output.

Save/Print Options
When printing a file that is processed by the PostScript interpreter 
(PostScript files or any image that is scaled, rotated, etc.), you can print 
directly from the bitmap created by the RIP. This can be accomplished 
by creating an intermediate RTL file so that the printer is never waiting 
on the RIP. 

The intermediate files can be saved for future use by selecting either the 
Save File and Print or Save File Only, No Print options. If you want the 
intermediate file automatically deleted following printing, select the Print 
Only, No Save File option. Output directly to Printer will save time if you 
do not need to create intermediate files.

Intermediate files for layouts, as opposed to single files, can also be cre-
ated. All of the options in this dialog take effect for layouts whenever the 
Direct to printer checkbox is not selected in the Layout Options dialog.

RTL files are created by default. An RTL file is smaller than its equivalent 
TIFF, at least 8 times smaller and often, especially in drawn images that 
can be compressed, much smaller than that. Furthermore, TIFF and CT 
files still need more processing during printing. RTL files are completely 
ready for printing and should stay well ahead of the printer. RTL files may 
take longer to create in the first place, but will be faster once printing 
begins. Anyone printing to more than one printer simultaneously should 
consider creating intermediate RTL files instead of TIFF or CT files.

Output Directory
The Output Directory is where the intermediate file is created, if a “Save 
File” option is selected. This entry is by default the subdirectory TEMP of 
the directory specified for ColorBurst installation. This directory is also 
used as the output queue in Spooling (if not otherwise specified in the 
Spooler dialog).
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Temporary Directory
Each time a layout is processed, ColorBurst creates temporary files. All 
files in a layout are ripped and saved as temporary files. After all files are 
processed, the temporary files are then assembled into a layout again 
and printed (or saved as one final file, depending on your output op-
tions). The temporary files are then deleted.

The Temporary Directory entry determines where ColorBurst saves the 
temporary files. The default path is the TEMP folder in the ColorBurst 
installation folder. It is recommended that the directory be a local folder, 
rather than on a server, so that the RIP time is faster.

File Name Template
This File name template edit box allows you to specify the name of an 
output file which will be created when only one image is processed 
into an output file. When there are two or more files in a layout, the 
File name template in the Layout Options dialog is used first, and then 
appended by the information in the File Name Template here. The File 
Name Template is described in detail earlier in this chapter, under Layout 
Options.

%P	 A special code, %P, has been added for use with 
this File Name Template (not the File Name Template 
in the Layout Options dialog). %P can be used for 
multipage documents, and will add the page number 
to the file name.

TIFF Byte Order
The TIFF byte order radio buttons allow you to choose between Intel 
and Motorola byte ordering when writing a TIFF file to disk. The TIFF file 
format begins with flags indicating whether the file uses Intel (low-high) 
or Motorola (high-low) byte ordering when specifying values larger 
than 8 bits. Although most software that reads TIFF format, including 
ColorBurst, can handle either byte order, some can only handle one 
type. This button allows you to specify the byte order used to write TIFFs 
so that ColorBurst TIFF files can be universally understood.
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Use PostScript Resolution in TIFF/CT Header
When a TIFF or CT file is created from either a PostScript file or a layout 
of multiple files, the resolution (lines per inch or lines per millimeter) 
placed in the file header is normally the resolution of the intended print-
er. When the Use PostScript resolution in TIFF/CT header box is checked, 
the resolution is set to the resolution that is specified in the Resolution 
edit box in the PostScript Interpreter Options dialog. This setting can be 
used when the TIFF or CT is intended for a device like a high resolution 
film recorder which supports, and scales to, any resolution. Only layouts 
and files running through the PostScript interpreter, including scaled 
TIFFs and CTs, are affected.

Single Strip TIFF
TIFF images can be made up of a series of strips, or bands, to al-
low smaller memory allocations when reading a TIFF image. When 
ColorBurst writes a TIFF file, it usually sets up strips to be the size of a 
band that is created by the PostScript interpreter. It has been found that 
some software packages do not read TIFFs that contain multiple strips. 
Selecting this checkbox forces the TIFF to be written as a single strip so 
such software can process TIFF files from ColorBurst.

Prompt for Output File Name
The final entry in this dialog is the Prompt for output file name check-
box. If this entry is not checked, then the file is saved with the current 
file name and an RTL extension. If checked, each file can be specifically 
named. As the file is about to be created, a Save As dialog will appear to 
let you name the output file.

When all entries in the Postscript/Layout Output File Options dialog are 
complete, select the Save button or press <Enter>. Selecting the Cancel 
button or pressing <Esc> will cancel all entries you made since opening 
the dialog. Selecting the Help button will open ColorBurst’s Help for the 
Postscript/Layout Output File Options dialog.



72 · Options Menu	 Layout Series

PostScript Options
The next item in the Options menu is PostScript Options. Selecting this 
will display the PostScript Interpreter Options dialog. The entries in this 
dialog setup the parameters for the JAWS PostScript Interpreter that is 
included with ColorBurst.

Figure 4.17. The PostScript Interpreter Options dialog.

Resolution and Scaling
The Output Resolution for the RIP can be set to any value in Resolution 
Units of either dots per inch (dpi) or millimeters (mm).

One way scaling can be accomplished is by modifying the Output 
Resolution. Some large format inkjet printers print at a fixed resolution of 
300 dpi. For example, to double the size of the image, you could change 
the Output Resolution to 600 dpi (twice the original size). To scale the 
image to 11⁄2 times its original size, the resolution value would be 450 
dpi. Changing the Output Resolution will scale all images in the layout. 
If you want to scale an images individually, set the Output Resolution to 
300 dpi and scale the images through the Scaling & Rotation dialog.

If the unit of measure selected in the Printer Options dialog is Pixels, the 
resolution entered here will be used to convert pixels to/from absolute 
units of measure, such as printers point or inches. Job titles appearing 
above each printed image are rasterized using this resolution regardless 
of the resolution of the illustration that it describes.
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Memory Limits
Memory Limits specifies how much memory will be allocated to the RIP 
for processing. It takes that memory when it is first initialized (the first 
time a PostScript file is interpreted) and does not return it until you exit 
ColorBurst.

The Total Allocation value refers to the amount of random access 
memory, or RAM, given to JAWS for interpreting the PostScript file.

NOTE:	 Try to ensure that the memory allocated is only real memory 
rather than virtual memory, because virtual memory will 
include disk space. If virtual memory is used, the time needed 
to access the disk can seriously impact the performance of 
the interpreter. Therefore reducing the Total Allocation (to 
eliminate virtual memory) can actually enhance performance. 
To test this scenario, turn off virtual memory. If the PostScript 
Interpreter can not run with that setting, reduce the Total 
Allocation.

The PostScript VM value is a portion of the Total Allocation described 
above. This is the portion of memory where the actual interpretation 
occurs. This memory is used by the interpreter internally for creating 
the displays and reading lists from the source file. The recommended 
value is 3 MB.

NOTE:	 Fonts take up a lot of VM memory. If many fonts are called 
in a job, you may need to increase VM. If you get a “font not 
found” error which seems incorrect, it may be that the font 
could not fit in VM. Increase VM size and try again.

The Initial Buffer Size entry is where you specify the size that the pro-
gram reserves for the initial buffer. The value you enter in the box will 
be interpreted as thousands of bytes or “Kb.” The minimum size of the 
initial buffer is 32Kb, but more than that will usually result in better per-
formance. The default size is 16000Kb.
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As a file is about to be printed or displayed, the initial buffer is divided 
into smaller chunks used for specific purposes, according to the type of 
file that is being read. Whatever is left over is used for reading the file. If 
the initial buffer is not large enough to handle the demand, the follow-
ing error message will be displayed: “Initial buffer too small. Increase size 
and restart.” Because the initial buffer is allocated when the program 
begins, changes to its size can only be accomplished by setting the new 
size, exiting, and restarting the program.

Output Format
The Output Format group allows you to specify whether a PostScript file 
should be rasterized using CMYK (cyan, magenta, yellow, black) or RGB 
(red, green, blue) colors or 256 shades of gray. Furthermore, you can 
Antialias the output using either color model. Antialiasing is explained in 
more detail below.

Click either the CMYK, RGB, or BxW radio button to select the color 
model. RGB refers to color. CMYK refers to the inks used to reproduce 
the colors. BxW refers to grayscale. CMYK is the default, and is most 
commonly used. Select RGB if you are outputting to an RGB file.‑If you 
select BxW when processing color files, an 8-bit file is created/printed.

Printing, of course, uses CMYK inks so RGB colors are converted before 
printing. Any conversion of RGB to CMYK uses the setup that you define 
in the RGB to CMYK dialog, or by the profiles in the ICC Profile Options 
dialog. This should allow you better control than letting the PostScript 
RIP convert an RGB image to CMYK for you. The default RGB to CMYK 
conversion used by a PostScript interpreter is to convert 100% of the 
neutral gray of the RGB colors to black, and remove 100% of the gener-
ated black from the CMY colors.

Antialiasing is a method by which sharp color transitions (also known as 
jaggies) are “smoothed.” Antialiasing is especially useful in smoothing 
the staircasing effect in large text characters by blending gray into the 
black to white transitions. Be aware, however, that antialiasing involves a 
considerable performance penalty!
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You turn on antialiasing by clicking the Antialias checkbox. You must 
then specify the number of samples and the formula to use for antialias-
ing. The number you enter in the Samples edit box sets the internal reso-
lution of the PostScript RIP. Using four samples at 300 dpi, for examples, 
actually rasterizes the images at 1200 dpi. Before outputting the raster 
image, however, the extra data is “res’d down” to 300 dpi. The Box and 
Pyramid radio buttons select the formula chosen to convert from the 
high resolution image back to the resolution of choice. The Box formula 
(sometimes referred to as “unweighted”) is considerably faster, often 
about 4 times faster, than the Pyramid (or “weighted”) formula, but 
Pyramid gives better quality. Note that at sufficiently high resolutions, 
“jaggies” are not nearly as problematic as at low resolutions. The Box 
formula may be a very good compromise between speed and quality.

When a “band” (a memory buffer about the size of Total Allocation 
minus PostScript VM) of raster information is ready, the appropriate 
antialias formula converts the entire band back to the resolution needed 
for output. An obvious effect of antialiasing is to notice very long pauses 
at regular intervals. The more Samples that you choose, the fewer the 
lines per band, so pauses come more frequently. Be aware that if at any 
time your RIP seems to be running much more slowly than you think it 
should, you may have antialiasing turned on inadvertently. Antialiasing is 
never in effect when you display an image on the screen.

Rotation
The Rotation box allows you to rotate all PostScript images in a layout 
90°, 180°, or 270° from each image’s original orientation. The T shape 
in the 4 boxes indicates the top of the image. By default, the upper left 
symbol will be highlighted, which means the image has not been rotated 
from its original orientation. You may rotate all types of images individu-
ally through the Scaling & Rotation dialog.

OverPrint Colors
The OverPrint Colors group allows color to “overprint,” or combine, as 
opposed to “knock out” colors below it. The CMYK checkbox is sepa-
rate from the two black overprint boxes. Overprinting can be very helpful 
for showing trapping and other effects, but it can also change the look 
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of the images, especially those that are intended for Level 1 PostScript 
interpreters. The file OVERPRT.EPS, included with ColorBurst in the 
TESTFILE directory, shows how CMYK overprint works. Display this file 
on the screen with CMYK overprint on and off and notice the difference.

Selecting CMYK overprint tells the PostScript interpreter to honor over-
print commands in the job. CMYK overprint only works when CMYK is 
set in the Output Format group—RGB and BxW ignore overprinting. 

Black overprinting is different than CMYK overprinting. It might only be 
noticed in the printed output. When black, especially text, is placed over 
other colors, it normally knocks out the colors below it, which may result 
in a white halo around the black. By turning on black overprint, the black 
is combined with the colors below it and the white halo disappears. 
Some black inks, when combined with other inks, may change hue. If 
this is the case, overprinting may be undesirable. You can specify black 
overprint for all generated black by selecting Black (Text&Graphics). 
Setting Black (Text Only) turns on black overprint for text but not for 
other black in the page, such as rules. Setting either turns the other off 
automatically.

Advanced PostScript Options
The Advanced button at the bottom of the PostScript Interpreter Options 
dialog opens the Advanced PostScript Options dialog. The information in 
this box is used by the PostScript interpreter, and usually does not need 
changed. If the information here is not correct, the PostScript interpreter 
will fail.

Initialization File
The file named in the Initialization File entry is needed by the JAWS RIP 
to set up its environment. The file should have been delivered on the 
installation diskette(s), and the name should have been entered during 
installation. This file is for internal use. It must exist and should not be 
changed except when specifically instructed. The initialization file calls 
many other setup files, also delivered on the installation diskette(s). If the 
initialization file or other files it calls are not found, the following error 
message results: “Error occurred before errordict set up. Check your init 
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files.” The initialization file is normally named INIT.PS and is placed in the 
LIB subdirectory under the directory you named during installation.

Figure 4.18. The Advanced PostScript Options dialog.

Temporary File
The Temporary File entry names a file that the JAWS RIP needs for stor-
ing internal information while it is interpreting and rasterizing PostScript 
files. The temporary file is used anytime JAWS needs more memory than 
is available to it in the Total Allocation buffer.

The Temporary File usually includes the full path of the temporary file. 
The path must exist. If the file cannot be created, you will receive the 
error message: “Temporary file for PostScript Interpreter cannot be cre-
ated!” The temporary file entry is usually filled during installation. The 
default name is JAWS.BND in the subdirectory TEMP of the directory 
specified for ColorBurst installation.

JAWS Search Directories
The directories named under the JAWS Search Directories group gener-
ally contain PostScript (.PS) files needed by the JAWS RIP. Files in these 
directory paths should not be altered except when specifically instructed. 

The entry boxes are usually filled during installation. The default name of 
the Lib Directory is LIB and the default name of the Resource Directory is 
RESOURCE. Both directories and further subdirectories are created under 
the directory that you name during installation.
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Currently, the OS Directory edit box, intended for specific operating sys-
tem setup, is not used. Its default name is the directory you name during 
installation.

The Widen image to pixel boundary checkbox is on by default. This 
checkbox should be left on to avoid roundoff errors when scaling and 
tiling images at high percentages.

The Spill large images to disk checkbox is also on by default. This checkbox 
allows newer PDF formats to buffer to disk as required during processing. 
Leave this checkbox on to avoid errors when processing PDF files.

NOTE:	 If the PostScript interpreter has already been initialized, the 
following message will result: “Restart ColorBurst to have 
changes take effect.” All changes except Resolution will not 
take effect until ColorBurst has been re-launched. Resolution 
changes will take effect with the next job.

ICC Profile Options
Kodak Digital Sciences’ ICC Engine, referred to as KCMS, is integrated 
into ColorBurst. KCMS is an industry-accepted color correction system 
which can enhance the current color correction within ColorBurst or 
completely replace it. KCMS works from pre-built ICC Profiles, allowing 
you to print CMYK, RGB, and grayscale files, with both vector graphics 
and photographic images, in the same layout and get good output for 
each type of image. You can choose different profiles for different types 
of output, such as RGB, CMYK, or Hexachrome.

KCMS is embedded in the ColorBurst RIP. Any job running through the 
PostScript interpreter has its colors corrected while being interpreted. 
When a file is printed that does not go through the PostScript interpret-
er, ColorBurst uses the KCMS ICC Profiles to correct the image on a pixel 
by pixel basis.

The ICC Profile Options dialog allows you to set ICC Profile options. 
Profiles can be turned on or off without restarting ColorBurst to have 
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changes take effect. In addition, you may inhibit specific ICC Profiles by 
using the On/Off buttons. The dialog is separated into tabs; it opens in 
the Input Profiles tab.

General tab

The General tab in the ICC Profile Options dialog gives you control over 
which color management tools to use in ColorBurst.

Figure 4.19. The General tab of the ICC Profile Options dialog.

Enable ICC profile color management
The ICC Profile Options dialog allows you to turn ICC Profile correction 
on and off. When you turn off ICC Profiles, normal ColorBurst correction 
is used automatically, and all ICC options are disabled. If ICC Profiles are 
enabled, the image is corrected by the ICC profiles first, then corrected 
by ColorBurst.
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Print lin target
The Print lin target option is used only when printing a lin target for 
relinearization—lin targets should always be printed with ICC turned 
off. This checkbox eliminates the need to turn ICC back on after print-
ing your lin target.

Cancel print if output profile is missing or in error
When this option is selected and the output profile can not be found or 
is incorrect, the Print command will be canceled. This allows you to save 
media if the output profile is not found.

Create color corrected TIFF/CT
Select the Create color corrected TIFF/CT option to force ICC color cor-
rection when any file is converted to a TIFF or CT output file through the 
PostScript interpreter. Header information will inhibit ICC profile correc-
tion on files if they are subsequently printed by ColorBurst. If you convert 
an ICC profile-corrected file to a different file type, the new file will also 
be noted as color corrected.

Use embedded profiles
The Use Embedded Profiles checkbox is available for users that embed 
profiles in their images using programs such as Photoshop. When this 
box is checked and an image file contains a profile, the input profiles in 
ColorBurst are ignored and the embedded profile is used as an input 
profile instead. If this checkbox is not selected, any embedded profiles 
are ignored.

Enable AutoSpot for optimized PANTONE® colors
When this option is selected, ColorBurst will automatically find any 
PANTONE spot colors during file processing. AutoSpot’s color optimiza-
tion allows for greater accuracy of PANTONE colors.

Convert PANTONE® colors to process before color correction
When this option is selected, ColorBurst will automatically find any 
PANTONE spot colors during file processing and convert them to CMYK 
process before color correction takes place. This can be used as a work-
around for files that contain a PANTONE colored vector graphic that 
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overlaps a transparent object, drop shadow, or other bitmapped object. 
The vector and bitmapped objects will print correctly but the PANTONE 
spot color matching will be compromised.

Include media tint as background
The Include media tint as background option is used only when Absolute 
Colorimetric is selected as your input profile rendering intent. When this 
checkbox is selected, the input profile’s “paper white” will be preserved. 
This white value is often a slight tint and will be printed as the back-
ground color. If this checkbox is off, the Absolute Colorimetric white 
value will be forced to white (C=0%, M=0%, Y=0%, K=0%).

Grey vectors and images
These options control how black and white images print. When black 
and white images are corrected using ICC profiles, small amounts of 
cyan, magenta and/or yellow ink are often added to black to neutralize 
the printer's black ink. To print black and white images using black ink 
only, select the Inhibit ICC Correction checkbox.

If Inhibit ICC Correction is not selected, ColorBurst will use the Grey 
vector and Grey image Input Profiles (in the Input Profiles tab) to process 
black and white images using all inks. 

When the Grey Input Profiles are not available (i.e. not specified in Input 
Profiles or not found), there are three options for handling black and 
white images. You can either convert the image to RGB and use the RGB 
input profile, convert the image to CMYK and use the CMYK profile, or 
inhibit ICC correction and print the image using black ink only.

Enable ColorTrack
ColorTrack is a method by which ColorBurst eliminates the speckled look 
of pure colors that is typical of color profiling software correction. For 
example, in a light green tint, profiles will often add small amounts of 
magenta and even black. These magenta and black dots give the tint an 
undesirable grainy or speckled look. ColorTrack recognizes green as a 
pure color and eliminates the additional magenta and black dots that the 
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profile adds. This usually has no effect on scanned images where pure 
colors are unusual, only drawn images such as tints and blends.

When you select Enable ColorTrack, the other options in this group 
become active. You may set the individual ColorTrack thresholds for 
each ink color (Cyan, Magenta, Yellow, and Black ink). Setting a Cyan 
threshold of 10%, for example, will remove all cyan speckling from any 
area with up to a 10% cyan dot value (0% is white, 100% is the color 
at full strength). The threshold is subtractive, meaning that the threshold 
amount is subtracted from the ink value—if the threshold is 10%, then 
an 11% dot would print as 1%, a 12% dot would print as 2%, etc. 

NOTE:	 Yellow has no visible dot and mixes with other inks to change 
the hue, so it is strongly recommended that the Yellow 
threshold is set to 0%.

You may also choose to use ColorTrack only when specific pure col-
ors are being printed (Cyan, Magenta, Yellow, Red, Green, or Blue). 
Sometimes the speckles change the hue in a subtle way and it is not 
desirable to remove them. For example, this option allows you to decide 
to allow speckles to appear in a red tint, but not in a pure yellow tint.

Input Profiles tab

The Input Profiles in effect are specified in the Input Profiles tab. You 
may specify any or all of them—ColorBurst will use only the ones 
needed for each print job.

There are six different Input profiles listed in the Input Profiles tab. There 
are separate profiles for CMYK, RGB, and Grayscale data, in both vector 
graphic and photographic (image) formats.

To set a profile, use the On/Off button to activate it. When disabled, the 
name of the profile and its Find button will be grayed so that keystrokes 
and mouse clicks are ignored.
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The Find button allows you to browse for the proper profile. Each profile 
name entered is checked to see if it is a proper profile, and if it has the 
correct options for the entry you chose. That is, a profile for CMYK data 
will be improper if entered as an RGB profile name. If a profile is not 
found or improper, the previous name in that field will be re-established. 
A description of the profile will be displayed under the profile filename.

Figure 4.20. The Input Profiles tab of the ICC Profile Options dialog.

The Rendering Intent pop-up menu is used to define how the profile 
will remap the input colorspace to the output colorspace. Perceptual 
rendering will remap the input data evenly in the output data space. 
Colorimetric rendering will remap all out-of-gamut data to the closest 
possible value in the output colorspace, and all other data will remain the 
same. Saturation rendering tries to retain the same level of saturation as 
the original data, but at the expense of color hue. Absolute Colorimetric 
rendering is similar to Colorimetric, but uses an absolute white point as a 
reference. In general, use Perceptual rendering for photographic images 
and Colorimetric for vector graphics.
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Output Profiles tab

The Output Profiles are set in the same manner as the Input profiles.

Figure 4.21. The Output Profiles tab of the ICC Profile Options dialog.

Choose a Profile to manage and activate it with the On/Off button. Use 
the Find button to find the profile you want to use. The file is checked to 
make sure it is valid, and the description will appear below the filename. 
You may set profiles for output to a CMYK printer, an RGB printer, such 
as a film recorder, a Hexachrome printer (CMYK plus orange and green 
ink), and to the display monitor. Any of these can be disabled using the 
On/Off button.

The Stand-alone output profiles group lets you assign a rendering intent 
for input that is not included in the Input Profiles tab. This is helpful 
when processing L*a*b* files—L*a*b* files do not go through an input 
profile, so the rendering intent can be set here. The rendering intent is 
used the same way as described above in the Input Profiles tab.
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Simulation Profiles tab

Simulation, or proofing, profiles are used to simulate output to one type 
of printer on another type of printer. For example, you can simulate the 
output of a Mimaki printer on an Epson. The simulation is extremely 
accurate, as long as the output device has a larger ink color gamut than 
the simulation device. If you simulate a printer with a wider color gamut 
on a printer with a smaller gamut, some color clipping will occur.

Figure 4.22. The Simulation Profiles tab of the ICC Profile Options dialog.

The Simulate output to another printer button activates the Profile name 
entry box. The Simulation Profile is set in the same manner as the Input 
and Output profiles. Use the Find button to find the profile you want to 
use. The file is checked to make sure it is valid, and the description will 
appear below the filename. The profile can be disabled using the On/Off 
button. The Rendering Intent is used to remap the color from one type 
of printer to another; see Input Profiles (above) for a description of each 
rendering intent.
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The Use L*a*b* to L*a*b* profile for device matching checkbox allows 
you to use L*a*b* to L*a*b* profiles for simulation. L*a*b* is absolute 
color. When using this simulation, the total raw L*a*b* input data is re-
stricted to the L*a*b* color space of the device. Input data goes through 
the L*a*b* simulation profile and then out to the Output device profile. 
This is useful for devices that you cannot make an ICC profile for. It also 
allows you to stay in L*a*b* color, which is device-independent color.

Default Paths tab

The Default paths tab allows you to specify the default paths for Input 
and Output profiles. Use the Find button to select a folder for the 
default paths.

Figure 4.23. The Default Paths tab of the ICC Profile Options dialog.

The Copy button is used to eliminate paths in the profile names in the 
Input and Output Profile entry boxes. If any profiles are not located 
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in the default path, clicking the Copy button will copy the profile to 
the default path folder. This allows you to keep all of your profile files 
together. It is recommended that your default paths are local, rather 
than on a server.

When all entries in the ICC Profile Options dialog are complete, select 
the Save button to keep them or select the Cancel button to restore the 
values to their previous settings. You may access ColorBurst’s Help files 
about the ICC Profile Options dialog by selecting the Help button. 

Color Adjustments
The entries and modifications made in the Color Adjustments dialog 
control settings such as the screening, brightness, and ink density.

Ink Limits tab

The Ink Limits tab in the Color Adjustment Options dialog gives you ac-
cess to the Ink Limits, Sharpness, and Extra TIFF Channel controls.

Ink Limits
The Ink Limits group works with the Ink Limit test file (“Media Ink Limit.
eps”, located in the Testfile folder) to control the maximum amount of 
ink printed and avoid prints that are too wet. To determine the ink limit, 
print “Media Ink Limit.eps” and look for the last dry patch for all col-
ors. On glossy media, the wet patches may show ink running, while on 
matte media the paper may buckle. Another sign that the patch is too 
wet is rounded edges; on an acceptable patch the corners will be sharply 
defined. The number above the last dry patches (percentage of ink) is 
the number that is entered in the Total ink limit box. When the Enable 
Ink Limiting box is selected and a number less than 400 is entered in the 
box, the total amount of ink printed will be reduced to the percentage 
entered.
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Figure 4.24. The Ink limits tab of the Color Adjustments dialog.

The Black limit box works with Enable Ink Limiting; if Enable Ink Limiting 
is selected, Black limit becomes available. Selecting this box will keep 
black at the percentage entered when ink is limited using Enable Ink 
Limiting. For example, when Ink Limiting is not used or it is set to 400%, 
each ink is allowed to print at 100%. If Ink Limiting is set to 200%, each 
ink is limited to 50%. When each color is limited to 50%, it is difficult 
to get a rich black. If the Black limit percent is set to 80%, the other 
inks will be held back to 40% and black will print at 80%, producing a 
deeper black. The default (and minimum recommended) setting is 80%; 
a setting of 100% can create banding problems when printed.

Sharpness
The Sharpness factor will add electronic noise to vector blends, such 
as gradients created in Adobe Illustrator. The added noise will create a 
smoother blend and reduce the appearance of any banding that occurs.

The Sharpness factor can be set to any value from 0 (no noise) to 50. 
The recommended range is from 1 to 6.
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Extra TIFF channels
When alpha channels and spot channels are added to TIFF files in 
Photoshop or other imaging programs, the data in the channel is consid-
ered “negative” if the color indicates masked areas. Positive channels are 
created with color indicating selected areas.

By default, ColorBurst expects the channel data to be in “negative” 
format (masked areas are colored), which needs to be inverted to print 
properly. If you designed your alpha or spot channels in “positive” 
format (selected areas are colored), select the Change polarity of extra 
channels to positive checkbox to pass the data through as you see it on 
the screen in Photoshop.

Adjustments tab

The Color Adjustment Options dialog opens in the Adjustments tab. This 
is where the majority of the color settings are made.

Figure 4.25. The Adjustments tab of the Color Adjustments dialog.
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Screening (Finish)
Color data that is sent to a large format inkjet printer has to be patterned 
in some manner to give acceptable print quality. The three main formulas 
for patterning an image are dithering, error diffusion, and halftoning. 
Dithering is by far the fastest method, but its quality is lacking. There 
are many formulas for error diffusion, but the higher the quality of the 
image, the more calculations and thus the slower the print. Halftoning 
simulates output from a printing press. ColorBurst allows you to match 
your quality and speed requirements by selecting one of five screening 
formulas in the Patterned Finish group box. The five formulas are High 
Quality, Draft, Smooth Blends, Fast Images, and Halftoning.

When image quality is of utmost importance, select High Quality. This 
screening formula provides the finest print of all of the screening op-
tions, but is also the slowest. 

NOTE:	 When High Quality is selected and the print resolution is 
at 720 dpi, it is required to set the gamma to 1.0 in the Ink 
Limits tab (in the High Quality Screening group). 

The fastest pattern is Draft. It uses a dithering pattern with no error 
diffusion.

Smooth Blends and Fast Images are very high quality error diffusion 
patterns. Both eliminate any pattern in the output and give very simi-
lar printed results. Smooth Blends should only be used when printing 
blends (gradients) from vector data, because this option is slower than 
Fast Images. An alternative way to print vector data would be to raster-
ize your vector images in your drawing program (such as Illustrator or 
Freehand) and then print using Fast Images. 

The Fast Images pattern prints much faster than Smooth Blends and 
should be used when printing image (raster) data and vector data 
without blends. Because Fast Images is always done within the RIP, files 
that are not normally run through the RIP, e.g. unscaled/unrotated TIFFs, 
CTs, or Targa files, now must be encapsulated and run through the RIP. 
This extra time, especially for very large files, may offset any time savings 
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that you get from the faster screening. If much of your work does not 
go through the PostScript RIP now, you should run timing tests before 
deciding to use the Fast Images finish.

The Halftones Screening option will activate the Halftones tab in the 
Color Adjustments dialog. This tab is where you can select what type 
of halftone dot to use (Round, Cosine dot, etc.), as well as the halftone 
screen angles.

Brightness Control
The Brightness Control is independent of the other curves in the Color 
Adjustments dialog, and should be modified after setting the other 
curves, as it will make the entire image lighter or darker. To edit the 
Brightness curve, click on the Edit button to open the Brightness Curve’s 
Color Curve Information dialog.

Select Curves
The Select Curves pop-up menu gives you different settings for the 
four ink curves shown below the menu. To change an ink’s curve, click 
the Edit button to open the Color Curve Information dialog, described 
below. To adjust the percentage of maximum ink output, enter a value in 
the ink’s Max. Ink entry box, also described below.

Figure 4.26. The Select Curves pop-up menu in the Adjustments tab of the Color 
Adjustments dialog.

The first setting, Process Colors (CMYK), lets you control the amount of 
Cyan, Magenta, Yellow, and Black ink; these are the standard inks on 
every printer. If you are using the Pre-press version of ColorBurst, the 
Installed Ink Sets selection in the Spot Color Definitions dialog will affect 
these curves. The description of the Color Curve Information dialog has 
more information on changing the Process Color curves.
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The next setting, 6 Color Spot Inks is used in conjunction with the Spot 
Color Definitions dialog. If you add a Defined Spot Color to your Installed 
Inks list in the Spot Color Definitions dialog, a curve will be available for 
that spot color in the Color Adjustments dialog. The curve can be set for 
each spot color ink using the Edit button. The spot color named should 
correspond to an ink installed in your printer, as well as a defined color 
name in your file. The bottom two curves are disabled because there are 
only two definable spot colors using a 6 color printer.

The 7 and 8 Color Spot Inks selection works in the same way as the 6 
Color Spot Inks. The colors for each curve are named in the Spot Colors 
Definitions dialog. All four curves are available under this setting.

The Light Ink Conversion selection is used to support six color printers 
that have Light Cyan and Light Magenta ink. These curves function dif-
ferently from the Process Colors (CMYK) curves—they are used together 
to distribute the file’s data among the regular and light inks. The Cyan 
and Magenta curves in the Process Colors pop-up menu control the 
overall Cyan or Magenta ink, and then these curves control how the 
Cyan and Magenta color data is separated into the light and regular ink.

For example, the Light Cyan Curve Data may be set as follows: 0%=0, 
40%=100, 100%=0. Cyan would then be set to: 0%=0, 40%=0, 
100%=100. These settings indicate that from 0% to 40% data, the 
Light Cyan ink should be used, and the Cyan ink should be used for data 
over 40%.

When using Light Ink Conversion, it is recommended to set Cyan and 
Magenta Process Curves to 1, and Max Ink to 100%.

The 7 and 8 Color Light Inks selection works in the same way as the 6 
Color Light Inks. The color curves work together to distribute the data 
between the yellow and light yellow and black and light black inks. 
When you use a seven or eight color printer with all four light inks, the 
Process Colors curves, Light Ink curves and 7 and 8 Color Light Inks 
curves are all used together to process the image data.
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Edit Button and Color Curve Information
Selecting any of the Edit buttons in the Color Adjustments dialog (in 
each of the Ink Control and Brightness Control groups) opens a Color 
Curve Information dialog for that control. You will see the name of the 
curve at the top left corner of the Color Curve Information dialog above 
a graphical representation of the curve.

Figure 4.27. The Color Curve Information dialog. This dialog can be opened for each ink 
curve by clicking the Edit button in the Adjustments tab of the Color Adjustments dialog.

A curve converts input dot values that are read from the file being 
printed to output dot values that actually print. The curve can be edited 
in two ways. It can be treated as a mathematically smooth curve defined 
by one value, or it can be manually defined at various points.

Suppose, for example, you want to lighten the midtones of your black 
ink slightly while leaving the highlights and shadows basically un-
changed. In the Color Adjustments dialog select the Edit button in the 
Black Ink Control group. The Color Curve Information dialog appears. 
You might define one point on the curve to convert a 50% input dot 
value to a 45% output dot value. This would remap every input dot be-
tween 0% and 50% along a straight line from 0% to 45%. Every input 
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dot between 50% and 100% would be remapped along a straight line 
from 45% to 100%. This curve would convert a 25% input dot value to 
22.5% on output, and convert a 75% input dot to a 72.5% output dot. 

You might also choose to lighten the midtones by defining a curve as a 
mathematical formula. In this case, you would set the Use Curve check-
box and set Curve Value to 1.15. Now each point is mapped according 
to the formula. A 50% dot is converted to 45.06%, 25% is converted to 
20.31%, and 75% is converted to 71.83%.

If you are using a mathematically defined curve but want to make man-
ual adjustments to it, you can select the Edit Points button to convert 
calculated points from the mathematical curve to actual points on the 
curve as if you had entered each point manually. You can then edit these 
points as you wish.

You can manually adjust defined points on the curve either by enter-
ing precise values in the Curve Data table or by moving points with the 
mouse and watching the results.

Figure 4.28. Each curve can be edited manually in the Color Curve Information dialog.

The Color Curve Information dialog can be used not only to change 
an existing curve, but to view precisely how the curve remaps points. 
The Show/Hide button toggles between showing only defined points 
on the curve in the Curve Data table and showing all calculated points 
between the defined points. Calculated points are shown in gray and 
cannot be edited.

Max. Ink
The Max. Ink controls may be used when Enable Ink Limiting in not 
selected in the Ink Limits tab. In almost every case, ink densities for large 
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format inkjet printers must be reduced to eliminate pooling of ink on the 
media. The maximum printed ink that can be independently controlled in 
the Color Adjustments dialog by the Max. Ink (10-125%) edit box in each 
ink control group.

The four Max. Ink (10-125%) edit boxes should be the first controls 
adjusted when doing initial color calibration. For example, let’s assume 
you enter a value of 50% for the Cyan Max. Ink. This means that when a 
100% cyan dot is to be printed, only a 50% dot is actually selected. All 
other dot values are adjusted accordingly. When a 50% dot is specified, 
only a 25% dot is selected, etc.

Halftones tab

The Halftones tab is only available if Halftones is selected in the 
Screening (Finish) group. This tab contains halftone dot and screen 
settings.

Figure 4.29. The Halftones tab of the Color Adjustments dialog.
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Choose a halftone dot 
Halftone dots come in many different shapes, such as elliptical, round, 
diamond, and so on. The choose a halftone dot pop-up menu allows 
you to select the shape of your halftone dot.

Use AccurateScreens
The Use AccurateScreens checkbox will turn on Adobe AccurateScreens. 
This option will create smoother transitions, creating more shades of 
gray. It is recommended that this checkbox always be selected.

Adjust ruling
The Adjust ruling to position dots on whole pixels will adjust any partial 
dots to whole dots. It is recommended that this checkbox always be 
selected; partial dots may cause unwanted patterns in halftoned output.

Ruling (dots per inch)
The Ruling entry box allows you to enter the dots per inch to use when 
halftoning. The recommended value is 1/10th of your printer’s dots per 
inch. For example, if you are printing on a 360 dpi printer, set Ruling to 
36 dots per inch.

Screen angles
The Screen angles entry boxes contain the screen angles to use for each 
ink. Screen angles will be used for any installed ink, as set in the Spot 
Color Definitions dialog. The first four inks and their default screen 
angles are: Cyan at 75, Magenta at 15, Yellow at 0, and Black at 45 de-
grees. For additional installed light inks, the angles should be exactly the 
same as the CMYK angles—light inks are used to blend with the CMYK 
inks so they must overlap.

Linearization Options
The next selection in the Options menu opens the Linearization 
Options dialog. Linearization will allow you to standardize your color 
output by equalizing the steps between specified ink densities or 
chroma values. You can use the Linearization settings to create consis-
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tent output and match output from multiple printers of the same type 
(same ink and media).

For more information on Linearization and creating ICC profiles, please 
refer to the SpectralVision Pro documentation, found in your ColorBurst\
Profiling Tools & Docs folder.

General tab

The Linearization Options dialog opens in the General tab, where you 
can turn linearization options on and off and specify a LIN file.

Figure 4.30. The General tab of the Linearization Options dialog.

Allow linearization
Select the Allow Linearization checkbox to linearize your input data using 
a specified .LIN file. When creating a LIN file, do not select this box. The 
input data will not be linearized when this box is not checked.

Use chroma based linearization
The Use chroma based linearization checkbox is available when a LIN 
file that contains both ink density and chroma or L*a*b* data is loaded. 
When this checkbox is selected, the chroma or L*a*b* data in the LIN 
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file will be used to perform chroma based linearization, depending on 
the selection in the method pop-up menu, and the ink density data in 
the LIN file will be ignored. When this checkbox is not selected, the ink 
density data will be used for linearization and any chroma or L*a*b* data 
is ignored.

If you are relinearizing, you must make sure that the chroma based 
linearization method matches the original method used in the profile. 
When an environment is loaded, the correct method is chosen automati-
cally based on the profile’s data. Do not change this setting.

If the a LIN file containing chroma or L*a*b* data has not been loaded, 
this checkbox will be disabled (dimmed) and linearization will be based 
on ink density.

Print lin target
Select the Print lin target checkbox only when creating a linearization file 
or a new ICC Profile. This option will automatically be deselected after 
one print. This button will disable all ICC color correction so that the 
print will contain raw data, which can then be read by a spectrophotom-
eter to create an ICC profile based on the printer’s raw output.

Cancel job on linearization error
Select this checkbox to cancel your current print job when there is an 
error processing the linearization data. A message will appear indicating 
that there was a linearization error, and the current layout will not print. 
If this box is not checked and there is an error with the LIN file, printing 
will continue without linearization.

Linearization file and path
The Linearization file and path group contains fields for the lin-
earization file name and default path for LIN files. The data in the 
Linearization file (LIN file) is used to linearize your output. In order 
to linearize your input, a LIN file must be specified. When a LIN file 
is loaded, the Dmax or peak chroma values in the LIN file will be 
displayed in the Original and desired Dmax/Chroma settings group 
(directly above the Linearization file and path).
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You can use a LIN file by itself, or use a LIN file and Desired densities or 
chroma values. LIN files can be created on a regular basis to get a “read-
ing” of your printer’s current output, so that it can then be adjusted 
according to your Dmax or peak chroma values for consistent output. 

Dmax or peak chroma values should be set when an ICC profile 
is created. When Dmax or peak chroma values are specified, the 
Linearization file’s 100% values and the Dmax/Chroma values are com-
pared. The information in the current LIN file will be adjusted according 
to the Dmax/Chroma values. Using Dmax or peak chroma values can 
help you match output for multiple printers of the same type (using the 
same ink and media) and ensure consistent output on the same printer 
from day to day.

The Set Baseline button can be used as a shortcut to setting your desired 
Dmax/Chroma values. This button will set the desired Dmax/Chroma 
values to 5% below the Dmax or peak chroma of the LIN file. This is 
the same as to going to the Advanced tab, selecting Set desired Dmax/
Chroma from next read of linearization minus (-): and entering 5% as 
the value.

Advanced tab

The settings in the Advanced tab will override densities or chroma values 
set from the LIN file.

Desired density/chroma values
You may enter Desired density/chroma values, which are the ink densi-
ties or chroma values that you will use to standardize your output. In 
order for these values to be used, you must make sure the Use original 
Dmax/Chroma settings checkbox is not selected.

Different Desired values may be entered for each of the ink colors—
Cyan, Magenta, Yellow, Black, and up to 4 spot color inks. Values of 
25%, 50%, 75%, and 100% (the Dmax/peak chroma value) can be 
entered. ColorBurst will map the LIN file values to the target values 
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entered here. This is helpful if you already know the densities at which 
your inks should print (or chroma values if you are using chroma–based 
linearization). 

Figure 4.31. The Advanced tab of the Linearization Options dialog.

If any values are left blank, they will be calculated from the values that 
were entered to create uniform values. If all fields are blank, the LIN file 
will be used to determine the values.

Dmax/Chroma controls
The Dmax controls allow you to determine how the Dmax values are 
set. If you specify Use Dmax/Chroma from desired densities, the values 
entered in the Desired densities fields will be used (100% is the Dmax 
value). If you select Use original Dmax/Chroma settings, the 100% value 
will be read from the current Linearization file. 

An additional option, Set desired Dmax/Chroma from next read of 
linearization file minus (-) __%, is available in the Dmax/Chroma controls 
group. When this option is selected, the Dmax or peak chroma value is 
read from the linearization file and a threshold of __% is allowed. For 
example, if you enter 5% here, the Dmax or peak chroma value will be 
read from the linearization file and reduced by 5% of that value. This 
allows built–in headroom from the possible maximum value to the work-
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ing maximum value. This becomes very useful if an inkjet is clogged or 
another media is used and the maximum density or chroma reading is 
not as high in your LIN file as it is in the original LIN file. Entering a value 
here will make the lower reading acceptable. It is recommended to enter 
values in the range of 5% to 10%.

The Warn user when linearization’s Dmax/Chroma is less than desired 
option will alert you if the readings in your linearization file have shifted 
dramatically from your 100% Desired density/Chroma value. For ex-
ample, a shift of 0.05 in density is a natural occurrence, but a shift of 0.1 
would be a visible difference. If you do not want to print with a visible 
shift, you should enter a value of 0.1 in this box. It is not recommended 
to enter anything higher than a value of 0.2 here. When the Dmax or 
peak chroma value is out of range, ColorBurst will alert you so that you 
will know there is something wrong with your printer.

Set Dmax/Chroma button
The Set Dmax/Chroma button should be used to validate LIN files, and 
can also be used to replace Dmax/Chroma values. When the Use original 
Dmax/Chroma settings radial button is selected and the Set Dmax but-
ton is clicked, the Desired density Dmax value is replaced by the 100% 
value from the LIN file. To revert back to your previous values, hit the 
Cancel button.

When the radial button is not selected, the Set Dmax button will simply 
check header data and tags to verify that the LIN file is valid. A warning 
will appear if the file is not valid.

Data points tab

The Data points tab displays the individual ink density or chroma values 
from the most recent Lin file reading for Cyan, Magenta, Yellow, Black, 
Spot color 1, Spot 2, Spot 3, and Spot 4. The data here will be listed as 
ink density values unless the Use chroma based linearization button (in 
the General tab) is selected. If chroma based linearization is selected, 
chroma values are listed. This data can be used to determine if ink den-
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sity or chroma values level out in the 90% – 100% range. If the amount 
of gain for any ink is not at least .03 – .04, and the C, M, and K densi-
ties are at least 1.6 and the Y density is at least 0.9, then you can reduce 
the maximum value to the point where it declines or levels out without 
losing data. A new Lin file can then be made to create more tonal range 
and keep paper drier. (Chroma values will typically be in the range of 60-
80 for CMK and 85-110 for Y, and will vary based on the ink set).

Figure 4.32. The Data Points tab of the Linearization Options dialog.

To reduce the maximum value, make a note of what percentage the data 
is leveling out at. Close the Linearization Options dialog and open the 
Color Adjustments dialog. In the Max. Ink field for the ink you want to 
adjust, enter the percentage of ink where the data levels out. Once you 
have set your maximum ink percentages, go back into the Linearization 
Options dialog and turn Linearization off. Make a new Lin file and load 
the new Lin file in the General tab of the Linearization Options dialog. 
The data for the new Lin file will be displayed in the Data points tab.

For information on creating Lin files please refer to the SpectralVision Pro 
documentation, found in your ColorBurst\Profiling Tools & Docs folder.
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Ink Balance and RGB to CMYK
The Ink Balance and RGB to CMYK dialog allows you to control Ink 
Balancing and RGB to CMYK color conversion. This dialog is activated by 
selecting the Ink Balance item under the Options menu.

Figure 4.33. The Ink Balance and RGB to CMYK dialog.

The Ink Balance and RGB to CMYK dialog maintains two separate sets 
of controls. Ink Balancing is used as a final ink adjustment after all other 
color correction has taken place. RGB to CMYK is only used when RGB 
Output is selected in the PostScript Options dialog and you are printing 
to a CMYK printer (ColorBurst has to convert from RGB output to CMYK 
output). You choose which set of controls to edit by selecting either Ink 
Balance or RGB to CMYK in the first pop-up menu in the dialog. 

In each set of controls, you may enable and edit Black Generation, 
Undercolor Removal, and Ink Balance Adjustment. We recommend that 
you use black generation and UCR only when converting RGB to CMYK, 
and use Ink Balancing for all images as part of a final correction process. 
You can, however, set up Ink Balancing when converting RGB to CMYK, 
and you can specify Black Generation and UCR in the final correction 
process. This section covers why you might want to use these additional 
capabilities.
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Why would you use ink balancing when converting RGB to CMYK? RGB 
describes color; CMYK describes ink. Most CMYK images have already 
been balanced for ink mixtures through whatever process converted 
them to CMYK in the first place. SWOP ink standards are commonly 
used. This ink balance may not be right for your printer, but, if it is, you 
will not need to use ink balancing provided in ColorBurst.

An RGB image is converted to CMYK before any other correction takes 
place. The purpose of RGB to CMYK conversion, then, is to create as 
exact a duplicate as possible of the same image in its CMYK form. If you 
print both RGB and CMYK images, the more closely the conversion rec-
reates your CMYK images, the more precise your other color corrections 
can be. Describing ink balancing allows you better control of the RGB to 
CMYK process.

Why would you use black generation and undercolor removal during the 
ink balancing process? In theory, black is black so the addition of CMY 
has no affect. In reality, the additional CMY makes for a deeper black, 
and, according to how your inks interact, CMY might even change black 
to a dark brown. Dark areas in CMYK images often have both black 
and CMY. Eliminating some or all of the additional CMY, then, is an ink 
adjustment to allow better detail in dark areas.

When you specify black generation and UCR for both RGB conversion 
and ink balancing, these corrections take place twice when printing an 
RGB image. The same holds true for ink balancing. Because it is dif-
ficult to calibrate when both corrections take place, we recommend 
that you separate the processes as we have described in the calibration 
procedures.

Black Generation
The Black Generation group in the Ink Balance and RGB to CMYK dialog 
allows you to turn black generation on and off. When black generation 
is on, the items in this group set up the variables used in the calculation 
of the added black.
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The first item in the Black Generation group is the Enable Black 
Generation checkbox. When this checkbox is selected, black generation 
is active.

CMY is subtractive meaning that as more color is added, light is sub-
tracted. Saturated CMY is black. RGB is additive; adding color adds light. 
Saturated RGB is white. Equal amounts of RGB or CMY colors are gray, 
but in reverse order of each other. A CMY element made up of 20% 
cyan, 30% magenta, and 40% yellow shares 20% gray because it has 
at least 20% of all three colors. An RGB element made up of 20% red, 
30% green, and 40% blue, shares 60% gray. That is, 20% red is still 
80% black, 30% green is still 70% black, and 40% blue is still 60% 
black. The RGB element shares at least 60% gray in all three colors. 
Black generation works on this shared gray.

Minimum Gray specifies a threshold where black generation begins. 
Black generation is effective in shadow areas of an image. Adding black 
to light grays often results in an unacceptably dark image. The Minimum 
Gray edit box allows you to specify what percent the gray shared by 
all colors has to reach before black generation begins. Remember that 
smaller percentages of RGB are darker so all three colors must be less 
than 60% to share 40% gray. The higher you set Minimum Gray, the 
darker the color has to be before black generation begins.

Maximum Black lets you specify the maximum amount of black that can 
be generated. Setting this to 80%, for example, will generate only 80% 
black from solid black. Black is generated in proportion to this value. 
That is, if a color generates 30% black when Maximum Black is set to 
100%, that same color will generate 15% black when Maximum Black is 
set to 50%.

The Curve allows you to enter a value from .3 to 4.0 to specify how fast 
black generation proceeds. Black generation starts when the shared 
gray reaches Minimum Gray, and ends at 100% black which generates 
Maximum Black. The value input is represented graphically below the 
entry box. The value represents an exponential curve similar to a gamma 
curve. Entering “1” is a straight line. Entering a value less than 1 gives 
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a curve above the straight line which represents more black generation 
than the gray that it replaces. A value above 1 shows a curve below 
the straight line which represents slower black generation. As the curve 
value becomes larger, a steeper curve results toward the black ink. This 
would represent very little black generation at the minimum gray end 
and very fast black generation at the maximum black end. A value be-
tween 1 and 2.5 will probably give you the best result. The default is 1.

Undercolor Removal (UCR)
The Undercolor Removal (UCR) group in the Ink Balance and RGB to 
CMYK dialog lets you turn undercolor removal on and off, and lets you 
specify the percent of generated black that is removed. When UCR is 
off, any black that is generated is added to CMY. When UCR is on, some 
part of the black that is generated is removed from CMY.

Enable UCR is the first item in the Undercolor Removal (UCR) group. UCR 
is active when the Enable UCR checkbox is selected.

The Maximum UCR edit box lets you specify what percent of the black 
generation value is to be removed from CMY. If, for example, Maximum 
UCR is set to 20% and 30% black is generated, then cyan, magenta, 
and yellow is each decreased by 6% (20% of 30%). Setting Maximum 
UCR to 100% subtracts all of the generated black value from CMY.

Ink Balance Adjustment 
The Ink Balance Adjustment group in the Ink Balance and RGB to CMYK 
dialog can be edited for adjusting ink percentages for printing CMYK im-
ages, as well as to control color conversion of RGB images to CMYK. You 
specify either of these sets of controls through the initial pop-up menu 
in the dialog.

When enabled, the controls allow you to specify red to be some percent 
of magenta and yellow inks, green to be some percent of cyan and 
yellow, blue some percent of cyan and magenta, and gray some per-
cent of cyan, magenta, and yellow. In the RGB to CMYK controls, these 
percentages are used in converting RGB to CMYK. For example, if red is 
specified to be 100% magenta and 50% yellow, when a 20% red dot 
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is converted to CMYK, it becomes 20% magenta and 10% yellow. After 
a line of data has been color corrected, but before it is halftoned and 
printed, the cyan, magenta, and yellow are adjusted according to the Ink 
Balance Adjustment specifications for the Ink Balance controls.

If you enable Ink Balance Adjustment controls for both RGB to CMYK 
and Ink Balancing, an RGB image will be corrected twice before it is 
printed; once for each set of controls.

Test Conversions 
The Test Conversions group in the Ink Balance and RGB to CMYK dialog 
displays the black generation, UCR and converted CMYK dot values that 
are calculated from any RGB or CMY percentages that you specify. In 
addition, the actual RGB color is displayed as a circle below the RGB edit 
boxes.

When the dialog first appears, the Test Conversions group displays a 
brief explanation plus the Red/Cyan, Green/Magenta, and Blue/Yellow 
edit boxes. When the RGB to CMYK option is selected in the pop-up 
menu, the values entered are displayed in a colored circle as percentages 
of RGB and two messages appear below the colored circle. The top mes-
sage informs you of the black generation value that has been calculated 
from the RGB percentages, and the bottom message informs you of the 
UCR value that has been calculated. Each message displays both the per-
cent and dot value. Dots are in the range 0 - 255, so 40%, for example, 
is equivalent to dot 102. Below this information, you will see Converts 
to: with the percentages of C, M, Y, and K that will be generated from 
the values entered. These percentages include ink balance calculations if 
they are in effect. When Ink Balance is selected in the pop-up menu, the 
values entered are assumed to be CMY, and the information is displayed 
accordingly.

The black and UCR calculations use the currently displayed items in the 
dialog, not the permanent values in effect. This allows you to change any 
or all of the settings in the Black Generation and Undercolor Removal 
(UCR) groups, run tests to see the effects that these settings have on 
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black generation and UCR, and then select the Cancel button to leave all 
current settings unchanged.

The display of the colored circle is only as good as the display hardware 
on your computer. Some display systems can only dither solid colors 
to give you the effect of the RGB colors. Other display systems should 
match the RGB colors quite closely.

Once all values in the Ink Balance and RGB to CMYK dialog are set, 
select the Save button to keep them or select the Cancel button to abort 
the values to their previous settings. You may access ColorBurst’s Help 
files discussing the Ink Balance and RGB to CMYK dialog by selecting the 
Help button.

Spot Color Definitions
The Spot Color Definitions dialog handles all files that have spot color 
data, including separated input such as DCS or pre-separated PostScript. 
The dialog contains four tabbed windows; it opens in the Spot 
Color Definitions tab.

Spot Color Definitions tab

The Spot Color Definitions tab allows you to enter the name and output 
values for each spot color.

Spot Color CMYK Values and Defined Spot Colors
ColorBurst has the ability to stitch together and print pre-separated 
PostScript files generated by page makeup applications. Each pre-sepa-
rated layer is named according to the process color or spot color used to 
print the layer. As ColorBurst encounters a separate layer, it displays the 
name of the layer in its message window. 

The process colors (CMYK) need no special setup. When a spot color 
name is encountered, however, ColorBurst needs a CMYK (or RGB) 
definition to represent that colored ink. If no spot color by that name 
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has been defined, ColorBurst skips the layer and adds the message 
“-ignored” after the spot color name in the message window. If a spot 
color name has been defined as some combination of inks, ColorBurst 
processes the layer and combines it with the process colors.

Figure 4.34. The Spot Color Definitions tab of the Spot Color Definitions, Ink Sets, and 
Separations dialog.

There are no predefined spot color definitions. It is the user’s responsibil-
ity to define all spot colors that he/she intends to use in pre-separated 
jobs. You may define an unlimited number of spot colors, however a 
maximum of 30 spot colors may be used per file. That means that a pre-
separated job can have up to 34 layers—4 process colors and 30 spot 
color layers. If more than 30 defined spot colors are included in a job, 
the 31st and greater spot color layers will be ignored. 
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The Spot Color Definitions dialog allows you to define an unlimited 
number of spot colors. To add a new spot color, enter the name of the 
spot color in the editable portion of the Defined Spot Colors pop-up 
menu. If a name is already there, overwrite it with the name you want to 
add. The name is not case sensitive; “red,” “RED,” “Red,” etc. all match 
the color “Red” found in a pre-separated job. Next, enter the values of 
Cyan, Magenta, Yellow, and blacK in the appropriate box in the Spot 
color CMYK values group. If you are using a six-color printer, you may 
also enter values for inks 1 and 2; if you are using an eight-color printer, 
you may also enter values for inks 3 and 4 to make the defined color a 
combination of up to all eight inks. However, if your 8-color printer uses 
light inks, do not set values for the light ink cartridges—these values are 
determined through color correction by ColorBurst. Each value can be 
between 0% and 100% in hundredths of a percent. 

Once you have the name and ink values showing in the proper fields, 
click the Add button below the pop-up menu. The new name will be 
added to the list in the pop-up menu with the values entered. To edit 
the ink values associated with this name, select the name in the pop-up 
menu, change any values, and click the Edit button. To delete the name 
and its values entirely, select it in the pop-up menu and click Del.

You may define a spot color using RGB or L*a*b* values as well as, or 
instead of, ink percentages. The RGB values will be used when output-
ting to an RGB film recorder, and are entered in the same manner as the 
CMYK values.

When trying to match a color that has already been printed, L*a*b* 
values can be used instead of CMYK values to recreate the ink color. 
A densitometer can be used on any printed swatch to find the L*a*b* 
values for that color. When the L*a*b* values are entered here, they will 
be interpreted through the current output profile to produce a print that 
matches your original swatch.

The CMYK and RGB color circles display the difference between the 
CMYK and RGB values. Please note that the CMYK color is used in this 
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display only, it does not represent output accurately due to the limita-
tions of the screen.

If you make changes without clicking Add or Edit and you close the dia-
log using the Save button, the current ink values will be saved under the 
current spot color name. If you want to exit the dialog without keeping 
your changes, be sure to use the Cancel button to close the dialog.

Clear all spot colors button
The Clear all spot colors button will erase the entire list of spot colors. 
This button does not give any type of warning message, so make sure 
not to press it unless you are sure you want to delete all of your spot 
colors from the list. Once it is pressed, the colors are gone.

Treat all suffixes as same spot color
This checkbox allows you to specify that all spot colors beginning with 
the same name be treated as the same color. To do this, select a spot 
color name from the pop-up menu, click the Treat all suffixes as same 
spot color checkbox, and the click the Edit button. This must be done for 
each color one at a time. This is useful when printing files created from 
several different applications, since each supplies the same information 
with different names in the suffix.

If entered, use L*a*b* to process named colors
If you enter L*a*b* values for a Spot Color Name and this option is 
selected, ColorBurst creates the CMYK spot color values on-the-fly using 
the L*a*b* values, based on the current ICC Output profile. When this is 
not selected, the CMYK values from the Spot Color Name list are used.

Allow import file to overwrite spot colors and Import button
The Import button is available for users of Praxisoft’s VectorPro and simi-
lar programs. This program can export a text file with a list of spot color 
names and their CMYK values, based on ICC profiles that can be built to 
match your ink and paper. The Import button will read this list of color 
names and values, and will add each spot color to ColorBurst’s Defined 
Spot Colors list. The Allow import file to overwrite spot color checkbox 
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will rewrite any existing spot colors that have the same name as a spot 
color named in the text file that is being imported.

Add message for each spot color name
When this checkbox is selected, a message is added to the Messages 
window for each spot color name encountered in the PostScript job. You 
must have a Display monitor Output Profile specified in the ICC Profile 
Options for ColorBurst to create spot color messages.

Import from PS button
The Import from PS button will read spot color names and values from 
a PostScript file. When you click the Import from PS button, a standard 
Open window appears, allowing you to select a PostScript file (.PS, .EPS, 
.PDF, or .DCS). When the selected file is opened, it is ripped and each 
spot color found in the file will be added to ColorBurst’s Defined Spot 
Colors list. The Message window shows the number of spot colors found 
and added to the list. This button should be used before opening files in 
a layout.

When the Allow import file to overwrite spot color checkbox is selected, 
the spot colors in the PostScript file will overwrite any existing spot colors 
that have the same name.

Select and Save Spot File buttons
The Select Spot File and Save Spot File buttons let you save and retrieve 
different sets of Spot Colors. Clicking the Save Spot File button opens a 
standard Save dialog and the Select Spot File button opens a standard 
Open dialog. Spot color files are saved with an extension of .spt and 
contain a list of spot color names and their ink values. No other settings 
in the Spot Color Definitions dialog are saved in a .spt file. The default 
location for .spt files is in the spot folder in the ColorBurst install folder.

When you save a spot color file and then save a printer setup file, the 
printer setup knows which spot color file to use, so all color names and 
values are saved with that printer setup file.
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Clear Last Spot File
The name of the Last spot file in effect will be displayed at the bottom 
of the Spot Color Definitions window. You can clear, or remove, the last 
spot file using the Clear Last Spot File button. This will remove the asso-
ciation with the last spot file, but the spot names and definitions will still 
appear in the list. You can remove all of the spot files from the list using 
the Clear all spot colors button.

Ink Sets tab

The next tab in the Spot Color Definitions dialog, Ink Sets, lets you 
specify the color of each ink cartridge installed in your printer. This is use-
ful when using Hexachrome inks or custom ink colors.

Current Ink Set 
The 6, 7, and 8 color ink set buttons determine which inks sets are 
available in the Current Ink Set pop-up menu. When the 6 color ink 
set button is selected, only 6-color ink sets will appear in the pop-up 
menu; when 7 color ink set is selected, the pop-up menu will show only 
7-color ink sets, and so on. Select an ink set from the pop-up menu that 
matches your printer and your job. The colors in the ink set you choose 
will show up in the Installed Inks menu. They will also appear in the 
Color Adjustments dialog’s Light Inks and Spot Inks sets, allowing you to 
adjust their curves and define their usage. You may delete installed inks 
to add more by using the Delete button. The Reset button will restore 
setting to their default and remove any inks added to the list, as well as 
reset any ink reordering below.

Defined Spot Colors and Installed Inks 
The Installed Ink list represents the colors, in order, of the ink cartridges 
installed in your printer. To define a Spot Color as an Installed Ink (the 
spot color must first be created in the Spot Color Definitions tab), click 
the arrow button between the Defined Spot Colors and Installed Inks 
pop-up menus. Your spot color will now be listed in the Installed Inks 
pop-up menu. ColorBurst now recognizes your extra ink cartridge as the 
color you entered in the spot color. The new Installed Ink can be ad-
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justed in the Color Adjustments dialog, by selecting the appropriate Spot 
Inks curve in the Select Curves pop-up menu.

Figure 4.35. The Spot Color Definitions tab of the Spot Color Definitions, Ink Sets, and 
Separations dialog.

Reorder inks for output to printer 
The Enable reordering of inks checkbox is available for use with very 
customized printer ink sets. This setting will not be necessary for most 
printers. There is a separate setting (on/off) for each ink set.

When creating custom ink sets, the order of the inks is critical—the 
order of inks defined in ColorBurst must match the order of the ink car-
tridges in your printer. When Enable reordering of inks is selected, you 
have the ability to define the order of the installed inks in relation to the 
printer. This will define a new order for the data file sent to the printer.
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Light Ink Conversions 
The Light Ink Conversions group allows you to define which ink is used 
when creating light ink data. This setting is particularly helpful when 
using both medium and light inks. If light inks are installed in the printer, 
you must make sure that the correct ink is selected. For example, if Light 
Magenta and Medium Magenta inks are installed in the printer, make 
sure that Magenta is selected next to both Light Magenta and Medium 
Magenta. This ensures that any magenta data in the file is correctly con-
verted from magenta to light and medium magenta.

Separations tab

The separations tab tells ColorBurst how to handle pre-separated files.

Print Separations
When the Print separations individually checkbox is selected, each 
pre-separated file placed in a ColorBurst layout will print as separations 
instead of a composite image. This checkbox tells ColorBurst to ignore 
the rest of the settings in the Separations tab.

If Combine separations into multi image layouts is selected, ColorBurst 
will place each separation into the layout during processing. This check-
box can be used to save media.

Fast Separations
This checkbox tells ColorBurst to make the intermediate grayscale file 
smaller, for faster processing. It should be used with 4 or 6 color pre-
separated files that do not contain spot colors. Normally, separated data 
is 8-bit data which is merged to a final composite job for printing. When 
Use Fast Separations is selected, ColorBurst RIPs directly to 1-bit. This 
means that ColorBurst cannot merge custom colors, so spot colors are 
ignored. If you don’t want spot colors ignored, de-select the Print fast 
separations with spot colors checkbox; this will cancel the print job if a 
custom color is found.
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Figure 4.36. The Separations tab of the Spot Color Definitions, Ink Sets, and Separa-
tions dialog.

NOTE:	 If Fast Separations is selected, you must set Patterned Finish 
in the Color Adjustments dialog to Quality-Fast, and ICC pro-
files for Grayscale data must be turned off.

If Fast Separations is not selected, you have the option to use the Low-
res separations instead.

Use Low Resolution Separations
This option can be used to speed the processing of large separated files. 
When a pre-separated file is processed by ColorBurst, a grayscale inter-
mediate file is created from each separation, and then they are stitched 
back together to print the final image. The number entered in the Use 
Low Resolution Separations box is the percentage of the Layout DPI that 



ColorBurst RIP	Op tions Menu · 117

you wish to process the separations at. You may enter a value of 25% 
up to 100%. For example, if your layout is set to 600 DPI and you enter 
a value of 50% here, the intermediate grayscale files will be created at 
300 DPI. Creating smaller intermediate files can speed the processing up 
significantly. The file is then printed at the original resolution, or 600 DPI 
in this example.

Search All PostScript Files For Separations
When selected, ColorBurst will search the beginning of every PostScript 
file processed to determine if the file is separated or not. This is useful 
when processing files created in programs that do not include separa-
tion comments in the beginning of the PostScript file. If you are certain 
that a file is separated but ColorBurst is not outputting the separations, 
turn this checkbox on so that ColorBurst can recognize the separations. 
Otherwise, this box should be left unchecked, since searching each 
PostScript file will make processing slower. 

Default paths tab

The default paths tab tells ColorBurst where to look for spot color files.

Spot file path
The Spot file path entry is where ColorBurst will look when the Select 
Spot File button is used in the Spot Color Definitions tab. The default 
entry here is the Spot folder, located in the ColorBurst install folder.

Import file path
The Import file path is used with the Import button in the Spot Color 
Definitions tab. When the Import button is clicked, ColorBurst will open 
an Open dialog using the path entered here as the default path. The 
default entry here is the ColorBurst install folder; you should change it to 
wherever your Praxisoft files (or files from a similar program) are located.
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Figure 4.37. The Default Paths tab of the Spot Color Definitions, Ink Sets, and 
Separations dialog.

Tiling Options
The Tiling Options dialog can be opened by selecting Tiling Options 
under the Options menu.

The first options in the Tiling Options dialog let you choose the order in 
which the tiles print. Print rows prints tiles from the upper left to right, 
then the next row of tiles from left to right, and so on. Print columns 
prints tiles from the upper left to lower left, then the next column from 
top to bottom, and so on.

You may have all tiles in a job automatically fit into the current layout by 
selecting the Automatically include all tiles in current layout checkbox. 
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Any tiles that do not fit in the layout window will produce an error mes-
sage, “Image does not fit in layout.”

Figure 4.38. The Tiling Options dialog.

Tile Size
The Tile Size option lets you enter a tile Width and Height or set the tile 
size to the size of the current layout by selecting Set tile size from cur-
rent image area. If this box is not selected, you must add each tile to the 
layout individually.

Tile Overlap
The Tile Overlap option lets you enter how much overlap should be 
printed on each tile. The overlap area prints on all interior sides of each 
tile, and 1/4” long crop marks are printed outside of the overlap area for 
trimming. Overlap and crop marks are added to the tile size when you 
enter a tile Width and Height. Overlap and crop marks are included in 
the tile size when you select Set tile size from current image area.

Trim Outside Tiles
The Trim Outside Tiles group lets you define the amount of image to 
trim around the perimeter of the entire tiled image. This is an indepen-
dent measurement from the Tile Overlap, so that your perimeter trim 
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amount can be a different size than your overlap between tiles. A posi-
tive value entered here will place trim marks inside the image.

Minimum Tile Size
The Minimum Tile Size settings are optional; entering values here force 
tiles to be at least as large as the values.

Output file template
The Output file template edit box allows you to specify the name of an 
output file which will be created when saving a tiled image. Each tile is 
a separate file, unless there is more than one tile in the layout; a file will 
be created for the layout of tiles in that case. The File Name Template is 
described in detail earlier in this chapter, under Layout Options. 

In the Tile Output file template, %t adds the number of the tile (the 
number of the tile is affected by print rows/columns). In all other file 
name templates, %t will add the time the file was created.

The default setting is the filename (%f), incremental numbers (%u), and 
tile number (%t); this ensures that no files are overwritten.

Font Maintenance
The next selection on the Options menu is Font Maintenance. Making 
this selection will display the Font Maintenance dialog. This selection en-
ables the JAWS RIP that is used by ColorBurst, to update its list of known 
fonts, which is necessary for interpreting PostScript text commands 
when fonts are not included in the PostScript file.

ColorBurst recognizes three categories of fonts:

ATM, which have a .PFB extension,
True Type, which have a .TTF extension (usually found in the 
Windows directory),
Non-ATM fonts, which have various extensions. 

•
•

•
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These fonts may exist in three separate directories or they may all be in 
the same directory. Either way, ColorBurst must know where they are; 
enter the directory path in the selection boxes marked ATM Fonts, True 
Type Fonts, and Non-ATM Fonts.

Figure 4.39. The Font Maintenance dialog.

Font Path and Search String
To update the ColorBurst font list, first specify the Font Path (including 
drive letter) and Search string (this is usually just the extension; separate 
multiple types with a semi-colon). Then click the Update button.

If any files in these directories are not fonts, screen messages will inform 
you of these errors. Also, a completion message will signal the end of 
the update.

Automatic Overwrite
ColorBurst will not automatically overwrite an existing font with a new 
one without your permission, either by responding “Yes” to the over-
write verification or by pre-selecting the Automatic Overwrite checkbox.
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NOTE:	 The Save button only saves changes made to Path names 
in this dialog. The Update button updates the Font List and 
does not need to use this function. 

Choose Layout Window Font
The Select Font button opens a Font window that lets you select the 
screen font used by ColorBurst. You may choose any True Type font 
installed on your computer, using any mode (bold, italic, etc.) and any 
point size. This is only used for ColorBurst screen display such as file 
names in the layout window—it has no effect on files.

Cancel job if fonts are missing
Select the Cancel job if fonts are missing checkbox if you want to cancel 
printing when ColorBurst can’t find a font specified in a file. If this box is 
not checked, the font will be substituted and the file will print with the 
substituted font.

For more detailed information regarding fonts, font maintenance, and 
how to manually substitute fonts for those named in the PostScript 
input files, please refer to the ColorBurst Help files by selecting the 
Help button.

Miscellaneous
The Miscellaneous Options dialog is used to set up miscellaneous items 
that are not covered in other dialogs. Currently, two general categories 
are covered in Miscellaneous Options; turning on and off log file genera-
tion, and specifying APR (Automatic Picture Replacement) settings.

Figure 4.40. The Miscellaneous Options dialog.
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Log files are files which contain all messages generated by ColorBurst for 
one 24-hour period. The name of the log file is generated by ColorBurst, 
but you specify whether log files should be created, and, if so, where.

APR is a method by which high resolution images needed for printing 
are automatically substituted for low resolution images used during page 
makeup. APR was created by Scitex Corp. A different but similar process 
is OPI (Open prepress interface). At the current time, ColorBurst only 
supports APR.

Log File
You can save every message that is written to ColorBurst’s message win-
dow by turning on log file generation. Log file can be very helpful in list-
ing activities, showing files that were printed, and pinpointing problems.

Log files are turned on in one of two ways. The primary method of 
turning logging on and off is through the Miscellaneous Options dialog. 
The group named Log File has two items. The first is the Write messages 
to log file checkbox. If this is checked, logging is in effect. Selecting this 
item will turn logging on if it is off and off if it is on. The second item in 
the group is the Log file path edit box. You should specify the full path 
of where you want the log file to be created in this edit box.

There is also a short cut in the message window itself for checking and 
activating/deactivating logging. At the upper left corner of the mes-
sage window, a small rectangle can be selected to pop-up menu the 
window’s control menu. One of the control menu items is Write Log File. 
If this menu item has a check mark next to it, logging is in effect. If there 
is no check mark shown, logging is not on. You can click on this menu 
item to turn logging on if it is off and off if it is on.

A log file lists messages for one 24 hour period. Its name is generated by 
ColorBurst in the form “CBYYMMDD.LOG” where “YY” is the last two 
digits of the year, “MM” is the month, and “DD” is the date. For exam-
ple, a file named CB950130.LOG lists all messages that were displayed in 
the message window while logging was in effect on January 30, 1995. 
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The naming convention was chosen so that a directory list sorted alpha-
betically will show all log files in order from latest to earliest.

Automatic Picture Replacement
Automatic Picture Replacement (APR) is a process created by Scitex 
Corp. for substituting high resolution images needed for printing for low 
resolution images used during page makeup. APR is similar to OPI and 
is made up of a series of comments in a PostScript file which defines 
the name of the high resolution file. You turn searching for APR com-
ments on an off, and you define search paths where ColorBurst looks for 
replacement files in the Miscellaneous Options dialog.

The APR Search in effect checkbox turns searching on and off. If the 
checkbox is selected, APR searching is in effect. When searching is 
on, ColorBurst looks for APR comments in the PostScript file as it 
is being read. If comments are found, ColorBurst checks that all re-
quired information has been found. Once found, all defined paths are 
searched looking for the file named in the APR comments. When found, 
ColorBurst checks that the file is a proper file type (TIFF, JPG, CT, EPS, 
etc.) and substitutes the file in place of the APR comments. Note that 
there is a small performance penalty encountered when searching for 
APR comments. If you never use APR substitution or you know that a file 
has no APR comments, it is better to turn off APR Search in effect.

When selected, the Error if replacement not found checkbox will report 
an error during processing if the file named in the APR comments cannot 
be found in the path specified in the Search paths pop-up menu.

The file named in the APR comments is assumed to have no pathing 
associated with it. You must define all paths where the high resolution 
file might be found in the Search paths pop-up menu. Search paths is 
a combination box with an edit box for entering names and a pop-up 
menu for listing existing names. You first enter the edit box. With the 
keyboard use up and down arrows to list all defined search paths one-at-
a-time. Using the mouse, click on the arrow next to the edit box to list 
as many search paths as will fit in the pop-up menu. If necessary, a scroll 
bar will display to allow you to scroll to the top or bottom of the list.
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Up to 8 search paths can be defined. There are three buttons used for 
changing the search paths. Use Add to add new search paths, Edit to 
change the name of an existing path, and Del to delete a defined path 
from the list. If adding a new path, overwrite any name in the edit 
box with the name of a path that you want to add. When the name is 
correct, select the Add button. You can then look at the defined paths 
in the pop-up menu to see that the new path has been added to the 
bottom of the list. To change an existing path name, select the path that 
you want to change so that it appears in the edit box. Change the name 
and select Edit. When you look at the list in the pop-up menu, you will 
see that the name of the search path has been changed. To delete an 
existing path, select the path so that its name appears in the edit box. 
Select Del to delete the name from the list.

The name of the high resolution file may have a long file name from a 
Macintosh workstation. Currently, ColorBurst can only search for long 
file names using AFP (AppleTalk Filing Protocol) services on a Novell 
Netware LAN. Before searching for a file, ColorBurst opens AFPWARE.
DLL which is delivered with ColorBurst. This checks for a Novell LAN, 
and, if available, uses AFP services to find the file name. If a Novell LAN 
is not available, the short name of the file is searched for which is usually 
the first eight characters of the name.
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5

Spooler Menu

The fourth menu item is Spooler. This setup will automate the printing 
process by monitoring up to fifty specified directories, or queues. Each 
queue is defined by the settings in the Setup Spooler dialog and, most 
importantly, a printer setup file.

Figure 5.1. The ColorBurst Spooler menu.

The Setup Spooler dialog allows you to define a queue’s Output queue, 
Done queue, whether layouts are on, etc. For example, you may define 
one queue to print single files and another queue to print layouts.

Choosing Save Printer Setup from the Options menu saves the cur-
rent Options settings in an printer setup file. This allows you to further 
customize each queue. For example, you can set up several queues and 
have each go to a different printer, each may have different resolutions, 
different color corrections, different image areas, another queue may 
save files without printing, etc.

Setup Spooler
The initial selection on this pop-up menu is Setup Spooler, which will 
display the Setup Spooler dialog.



128 · Spooler Menu	 Layout Series

Queue to Monitor
The Queue to monitor pop-up menu allows you to define up to 50 
unique queues. You may set the maximum number of queues that you 
want available in the Maximum queues edit box located near the bottom 
right corner of the Setup Spooler dialog. All of the other options in the 
Setup Spooler dialog (except the Time between checks option) are tied 
to the Queue to monitor; when you select a queue, the other settings 
define that queue.

Figure 5.2. The Setup Spooler dialog.

To define a queue, enter the full path of the directory that you want 
ColorBurst to monitor in the Queue to monitor entry box. The Find 
button to the right of the entry box makes it easy for you select a folder 
to monitor. If the folder does not exist yet, you may enter a name and 
ColorBurst will create the folder for you. Next, enter the Queue Support 
information (either manually or using the find buttons) and choose any 
other options in the Setup Spooler dialog that you wish to define for that 
queue (see below for more details). Once you have defined the queue, 
select the Add button to add the queue to the pop-up menu list. To edit 
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an existing queue, select the queue from the Queue to monitor pop-
up menu, make any changes, and select the Edit button. To delete an 
existing queue, select the queue you wish to delete from the Queue to 
monitor pop-up menu and select the Del button.

Queue Support
The Queue Support group contains six editable pop-up menus that are 
used to define the queue shown in the Queue to monitor entry box. In 
each of these boxes, except the Files to monitor box, the full path of the 
directory must be entered.

The Output queue entry is where the bitmap (TIFF or CT) or output is 
placed upon completion. If files are to be printed and not saved, the 
temporary files will be created here unless a Temporary queue is named. 
When both are named, a file that will be deleted will be created in the 
Temporary queue. If no output queue is defined, the output file will be 
created in the Output Directory specified in the Postscript/Layout Output 
File Options dialog.

The Done queue is where the input file is moved upon completion of the 
job. If no done queue is entered, the file in the monitored queue will be 
deleted, and no copy of it will be retained.

NOTE:	 The Done queue should be on the same disk volume as the 
Queue to monitor for a file to be able to be moved into 
that Done queue. Otherwise, the file is copied  to the Done 
queue. If the file is very large, a copy instead of a move will 
seriously affect performance. 

The Temporary queue is reserved for temporary intermediate files and 
job title files created during spooling. When images that are sent to the 
spooler are processed by the PostScript interpreter (PostScript files and 
any scaled, rotated, or cropped file), they may be converted into bitmap 
files before they are printed. These files are saved in the Output queue. If 
they are to be deleted after printing, and a Temporary queue is specified, 
the files will be created there instead of in the Output queue, and will 
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then be deleted after printing. If the output queue is not on a local disk, 
it is a good idea to create a Temporary queue to relieve network traffic.

Any files that create an error during spooling are moved to the Error 
queue. If an Error queue is not defined, the files are moved to the Done 
queue instead.

The Printer Setup file is the most important part of multi-queue. It tells 
the queue how to handle the files during spooling. It contains settings 
for all dialog options that take effect without restarting ColorBurst. This 
feature allows you to customize each queue. 

When setting up a queue to monitor, you should already have an idea of 
what you want that queue to do (which printer to send the monitored 
files to, image area size, what type of color corrections, etc.). To give 
your queue the appropriate characteristics, you need to create an Printer 
Setup file for your queue. In each of the Options menu dialogs, make 
the selections that you want to define your queue. Then select Save 
Printer Setup from the Options menu. The entire name (drive, path, and 
file name) entered when saving the printer setup file should be entered 
in the Printer Setup file edit box in the Setup Spooler dialog. When the 
queue is monitored, it will use the printer setup file’s settings to process 
the files.

A file named CURRENT.ENV is created when spooling begins holding the 
current printer setup file. It is used as the printer setup file whenever a 
printer setup file is not named. CURRENT.ENV is deleted when spooling 
is turned off. For these reasons, you should avoid naming a printer setup 
file CURRENT.ENV.

The type of file to monitor may be specified in the Files to monitor (*.*) 
entry. The file type may be a specific extension (such as “*.TIF”), a key 
letter or numeric sequence (such as “PG12*.EPS”), or all files (using the 
*.* argument). You may specify to monitor more than one type of file 
by separating entries with semicolons (“*.TIF;*.EPS”). If no file type is 
entered, all files (*.*) will be monitored.
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Special button and Special Queue Setup
The Special button in the Spooler dialog opens the Special Queue Setup 
dialog. This dialog is used to automatically scale every image in a queue 
and to print multiple copies of spooled files.

Figure 5.3. The Special Queue Setup dialog, opened by clicking the Special button in 
the Setup Spooler dialog.

The Scale all images in queue checkbox enables scaling of all images 
in a queue. When selected, five scaling options are available. The first, 
Scale all files to width of layout area, will scale each file in a queue to the 
width of the layout area (set in the Printer Options dialog). The second 
option, Scale all files to height of layout area, scales all images in the 
queue to the height of the layout area. The third option is to Scale by 
percentage. 100% is the original size of the image. Any number less 
than 100 will make the image smaller, and any number greater than 100 
will enlarge the image. The fourth and fifth options allow you to scale 
all images in the queue to a specified width or height by entering that 
number in the edit box.

The Number of copies to print checkbox allows you to specify how many 
copies of each file to print. If you have layouts turned on in spooler, each 
layout will print the specified number of times. The default value is 0, 
which is the same as 1. For more than one print, enter the number of 
prints you want in the edit box.
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Hide queue
Selecting the Hide queue checkbox will ignore that queue during spool-
ing. You will notice that any hidden queues are disabled under the 
Queue to Monitor pop-up menu. Deselecting the Hide queue checkbox 
will make the queue active again.

Include subdirectory images
The Include subdirectory images checkbox allows you to specify whether 
or not the queue’s subdirectories should be monitored during spooling. 

NOTE:	 If  the Include subdirectory images checkbox is selected all 
subdirectories will be monitored. Make sure your Output, 
Done, and Error queues are not set up as subdirectories of 
the monitored queue.

Move/Copy files only
When the Move/Copy files only box is checked, files in the moni-
tored queue are not placed in layouts — they are simply copied to the 
Output queue and moved to the Done queue. When the Done queue 
is not defined, files are moved to the Output queue. If no Output 
queue is defined, the files in the monitored queue are copied to the 
Output Directory, defined in the PostScript/Layout Output File Options 
dialog. The Message Window will display information for each file 
copied or moved.

The Move/Copy files only option can allow ColorBurst queues to be used 
in a more general purpose manner, to be used as part of other spoolers 
on a system, or to add better flow control. You can restrict which files 
will be processed by setting up acceptable file names in Files to monitor 
(*.*). Files that are processed, however, do not have to be image files 
that ColorBurst can print.

Convert Only Options
All files processed by the Spooler will be printed unless the Convert only, 
no print checkbox is selected. Selecting this checkbox will enable the 
Convert to TIFF file and Convert to Scitex CT file option buttons.
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For example, to convert a PostScript image to a Scitex CT through the 
Spooler, perform the following steps:

Select the Convert only, no print box.
Pick the Convert to Scitex CT file option.
Enter the PostScript image file type (such as *.EPS;*.PS) in the Files to 
monitor (*.*) entry field.
Start the Spooler. 

Each file opened by the Spooler will be saved as an individual file. The 
Layout queue files checkbox is disabled when Convert only, no print is 
selected. If a CLF is processed when Convert only, no print is in effect, 
each file pointed to by the CLF is converted to the desired file type. 

You may create one TIFF or CT file of your entire layout as opposed to 
creating many individual files. This may be accomplished using the Output 
Options and Save/Print Options in the PostScript/Layout Output File 
Options dialog box. To create TIFF files, set Create TIFF file and Save File 
Only, No Print. To create CT files, set Create Scitex CT file and Save File 
Only, No Print. Then turn the Spooler on by selecting Spool in the Spooler 
menu. TIFF files will have the names LAYOUT.TIF, LAYOUT.T00, T01, ... T99, 
and CT files have the name LAYOUT.CT, LAYOUT.C00, C01, ... C99.

Layout Options
The Layout Options group allows you to have layouts in effect when 
Spooler is on. Rather than having each file printed as it enters the queue, 
you can specify that files should be added to a layout. When the layout 
is full, it is either automatically printed, or saved as a layout file to let 
you print the layout when you are ready. You specify what to do when 
the monitored queue is empty before the layout is full. You can have 
the layout automatically printed/saved, have the layout printed/saved 
once some specified percent of the media is full, or wait until a defined 
timeout has been reached.

Layout files
The Layout queue files checkbox in this group determines whether files are 
printed individually or added to a layout for printing. If the checkbox is se-

1.
2.
3.

4.
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lected, all files will be added to layouts as they are processed. If the check-
box is not selected, individual files will be printed as they are processed. 

If the file to process is a layout file (CLF) containing pointers to more 
than one file and layouts are not in effect, the CLF is printed as if the 
layout had been built from individual files and the Print command issued. 
If a CLF is processed when layouts are in effect, individual files pointed to 
by the CLF are added to the current layout. 

If layouts are in effect, a file in the queue is added to the current layout. 
If a file does not fit in the layout, processing continues as if the queue is 
empty. That is, On Empty Queue determines whether to flush the layout. 
If the layout is flushed, the file oversetting the layout is added to the new 
layout created after flushing is complete. If the layout is not flushed, the 
file causing the overset is ignored until that layout is flushed.

Spooler always converts PostScript files to intermediate RTL files and 
adds the intermediate files to the layout. By adding only raster formatted 
illustrations to the layout, printing can start as soon as the media is full, 
and size discrepancy errors are eliminated.

A CLF named SPOOLER.CLF in the monitored queue saves the layout 
each time an illustration is added. Spooler deletes SPOOLER.CLF when 
the layout is flushed. If you stop Spooler and later restart, SPOOLER.CLF 
automatically builds the layout that was in effect, if any. This allows you 
to interrupt Spooler and later pick up exactly where you left off.

Save layouts
The Save layouts, no print checkbox is designed to stockpile layouts for 
printing at a later time. Save layouts, no print builds layouts exactly as if 
printing were to occur, but when the layout is flushed, SPOOLER.CLF is 
saved as SPOOLER.C00, SPOOLER.C01, ... SPOOLER.C99, called spooled 
layout files, in the monitored queue. Printing is inhibited and intermedi-
ate files are not deleted. When the printer is ready, you can turn off 
spooling, Open a spooled layout file and print it.
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Spooled layout files are designed to be printed only once. Temporary 
intermediate files pointed to in a spooled layout file are deleted after print-
ing, and other files have been moved from the monitored queue. Trying 
to print a spooled layout file a second time, will cause a series of “Not 
Found” messages. Spooled layout files are normal CLFs which are not 
automatically deleted. It is your responsibility to delete them after printing.

An alternative to spooled layout files might be to create a single RTL file 
which is the exact image of what would be printed. That is, do not select 
Save layouts, no print, but rather choose print options that create an 
output file and inhibit printing. If you want to transmit the output, it is 
easier to work with a single file rather than many files. Also, a single file 
may print faster. Spooler creates such files in the Output queue. RTL files 
have the names LAYOUT.RTL, LAYOUT.R00, R01, ... R99. Note that these 
names are given even if there is only one image in a layout. 

This is accomplished by not selecting the Direct to Printer checkbox in 
the Layout Options dialog. Output for the layout will then use settings 
established in the Postscript/Layout Output File Options dialog. To create 
RTL files, set Create RTL file and Save File Only, No Print. 

On Empty Queue
An important issue to resolve when spooling with layouts in effect is 
what action to take when the queue is empty. If a file oversets a lay-
out, it is treated exactly as if the queue is empty. For example, if there 
are only two small images in the layout and no files, or a file too large 
to fit in the layout, in the monitored queue, you might want to print 
immediately, or wait for more files. If a file is too large, and the queue 
is not printed immediately, the large file is ignored and all other files are 
processed normally. The On Empty Queue pop-up menu allows you to 
specify one of the following procedures:

Flush immediately
Flush on depth/timeout
Flush on area/timeout
Flush on timeout only 

•
•
•
•
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For example, if there is at least one file in the layout, and the queue is 
empty, selecting Flush immediately will cause the layout to be flushed. A 
message, “Empty queue – Flush immediate,” is reported in the message 
window.

Selecting Flush on depth/timeout or area/timeout allows you to specify 
either a minimum depth or area (depth x width), or a timeout that must 
be reached before the layout is flushed. When the queue is empty, the 
deepest image in the layout is calculated as a percent of the full depth 
of the media. If that percent is equal to or greater than the percent 
entered in the Min. Depth/area edit box, the layout is flushed. Reported 
in the message window is “Empty queue – Flush by depth/area.” If the 
minimum depth or area is not reached, Spooler calculates the number of 
minutes that have elapsed since the last file was added to the layout. If 
the number of minutes is equal to or greater than the value in the Time 
out edit box, the layout is flushed. The message reported is “Empty 
queue – Flush on time out.” If neither minimum depth/area nor timeout 
is reached, Spooler does not flush the layout.

Selecting Flush on timeout only is exactly like Flush on depth/timeout and 
area/timeout except that only a timeout value is checked. The number 
of minutes in Time out can range from zero minutes (the same as Flush 
immediately) to 480 minutes (8 hours).

Flush Button
At any time you can force a specified queue’s layout to be flushed by 
selecting the queue in the Queue to monitor edit box, and then selecting 
the Flush button. The next time that queue is monitored and found to 
be empty, the specified layout will be flushed with the message “Empty 
queue – Flush immediate.” Only the specified queue is flushed.

Time Between Checks
After a file has been processed or if no files were found in the queue, 
ColorBurst waits the amount entered in the Time between checks entry 
box before it checks the queue again or checks the next queue. The 
default interval is five (5) seconds. This value is not saved for each queue; 
it applies to all defined queues.
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Maximum queues 
You may set the maximum number of queues that you will need in the 
Maximum queues entry box. The maximum number of possible queues 
is 50. This value is read as ColorBurst is opened and memory is set aside 
for the number of queues specified. If you try to define a new queue 
when the maximum number of queues have been defined, the error 
message “Too many Spooler queues defined” will appear. You must 
restart ColorBurst before any changes to this value will take effect.

Spool
To activate the spooling process, simply select Spool under the Spooler 
menu. A check mark will indicate that spooling is in effect, and the 
message “Spooler started” is reported in the Message Window. When 
spooling is turned off, the message “Spooler stopped” will appear in the 
Message Window.
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6

Windows Menu

The Windows menu contains the Window Options dialog as well as three 
on/off settings for window and status placement in ColorBurst.

Figure 6.1. The ColorBurst Windows menu.

Window Options
The Window Options dialog allows you to customize the Display and 
Layout windows.

Figure 6.2. The Window Options dialog.
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The options in the Display window group affect the Display window only. 
The first setting, Rulers, can be set Off or On. The default setting is On so 
that rulers are visible in the Display window.

The Rotate BMP files option is used to determine how to handle 
displaying rotated files when a non–rotated preview bitmap file al-
ready exists. If Re–RIP file is selected, the rotated file is ripped when 
displayed. If the file is very large, this may take a few moments. To save 
time, the Rotate BMP option will simply rotate the preview bitmap file 
(the original file is not ripped over again). To save processing time when 
rotating a BMP, it is recommended to set the Bitmap resolution (below) 
to Low or Medium quality.

The Bitmap resolution setting controls the quality and file size of the pre-
view bitmap files used to display images. The quality can be set to Low, 
Medium, or High. As the quality increases from Low to High, the file 
size increases as well. Medium (the default setting) is recommended to 
give a decent display while keeping the file size manageable. Please note 
that bitmap preview images in the Layout Window are set to 1⁄2 of the 
Display resolution to keep file sizes and processing times at a minimum. 

The Layout window group contains settings that affect the Layout 
window. The Layout window Rulers setting is independent of the Display 
window Rulers setting (above); turning this setting on will make only the 
rulers in the Layout window visible. When Inhibit display of images in lay-
out is selected, images in the layout appear as boxes with the file name 
instead images, even when a bitmap preview file exists. When an image 
is displayed, a BMP preview is still created so that the image doesn’t have 
to re-rip when it is displayed again.

The Position dialogs on the screen is used to specify where on the screen 
to open dialogs. The default is centered—when a dialog is opened, it 
will open in the center of the screen. If a dialog with tabs, such as ICC 
Options, is open and the Layout window is open and clicked on, the ICC 
dialog will go behind the Layout. The Layout window must be minimized 
to get back to the ICC Options. If Upper left is selected, the ICC dialog 
will be in the upper left corner. Even if the Layout window is clicked, part 
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of the ICC Options dialog will accessible without the need of minimizing 
the Layout window.

Show Status Bar
The first on/off selection in the Windows menu, Show Status Bar, is 
used to control the visibility of the ColorBurst status bar at the bottom 
of the main window. The status bar shows a real-time status of settings 
in ColorBurst—whether Linearization, Ink Limiting, ICC Correction, Ink 
Balancing, and Cut Marks are on or off, and the selected printer, number 
of inks, and printer resolution. The options listed in the status bar are 
placed in order of their usage in the profiling process. These options are 
turned on or off in the corresponding dialog in the Options menu.

Auto Set Default Positions
Selecting Auto Set Default Positions in the Windows menu will automati-
cally place the File Info, Messages, and Layout windows in their default 
locations when ColorBurst is opened. The default positions allow for 
maximum use of the ColorBurst work area. A checkmark will appear in 
the menu next to this item when it is selected (in effect).

Set Default Positions
The Set Default Positions selection can be activated at any time while 
working in ColorBurst to automatically place the File Info, Messages, 
and Layout windows in their default positions. A checkmark next to this 
item in the menu indicates that the windows are already in their default 
positions. If any window is moved or changed, the item is no longer 
selected. The window positions and sizes can then be reset by selecting 
Set Default Positions.
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7

Help Menu

Help files are available for ColorBurst through the Help menu in the 
ColorBurst toolbar. Select Contents or the specific topic of your choice 
from the list in the menu.

Figure 7.1. The ColorBurst Help menu.

Help buttons are also available in every dialog. These buttons open the 
Help file about the dialog that you are working in.
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8

Message Window

ColorBurst features a “Message Window” that displays error and infor-
mation messages generated during ColorBurst processing. The processes 
that are specific to ColorBurst, such as the PostScript RIP, creating an 
RTL, TIFF or CT, and sending to a printer, will produce messages with the 
following format:

------------------------	 		  -separates jobs
C:\COLORBURST\CALIBRAT.EPS  	 -filename, in bold
Mon   02/13/06   10:26:28AM		  -time/date stamp
Sending to Printer				    -task
Elapsed Time:  00:01:45.6		  -elapsed time

Figure 8.1. The ColorBurst Messages window.

Messages will continue to accumulate in the window, which may be 
sized within the ColorBurst main window. It may also be closed through 
the pop-up menu on the control box, but will return to the screen upon 
starting another task or restarting ColorBurst.
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Other error and information messages that may occur during the RIP 
and printing processes will also display in the message window. These 
messages will be displayed line-for-line in the window. This type of error 
is ultimately written to the message window after first reporting via a 
standard Windows error dialog, on which you must select the Yes but-
ton to continue.

Figure 8.2. Information about processing, including error messages, is displayed in the 
Messages window.

The ColorBurst Messages window is scrollable. It currently has a 4K buf-
fer. As messages accumulate and the buffer is exceeded, the oldest ones 
will no longer be available.
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Appendix A

Fonts Delivered with ColorBurst

The following is the complete list of fonts included as part of the 
standard ColorBurst installation (the demo version does not include all 
of these fonts; only the substitute resource files). All fonts will reside 
in the FONT subdirectory under the directory specified during installa-
tion. Substitute Resource fonts are fonts that are actually set when the 
PostScript Font Name is called.

File Name PostScript Font Name Substitute Resource

ARI.PS Arial

ARIAB.PS Arial-Bold

ARIBI.PS Arial-BoldItalic

ARII.PS Arial-Italic

ARIN.PS ArialNarrow

ARINB.PS ArialNarrow-Bold

ARINBI.PS ArialNarrow-BoldItalic

ARINI.PS ArialNarrow-Italic

AGW.PS AvantGarde-Book CenturyGothic

AGWO.PS AvantGarde-
BookOblique

CenturyGothic-Italic

AGD.PS AvantGarde-Demi CenturyGothic-Bold

AGDO.PS AvantGarde-
DemiOblique

CenturyGothic-
BoldItalic

ZAPS.PS BookAntiqua

ZAPSB.PS BookAntiqua-Bold

ZAPSBI.PS BookAntiqua-
BoldItalic
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ZAPSI.PS BookAntiqua-Italic

BKD.PS Bookman-Demi BookmanOldStyle-
Bold

BKDI.PS Bookman-DemiItalic BookmanOldStyle-
BoldItalic

BKL.PS Bookman-Light BookmanOldStyle

BKLI.PS Bookman-LightItalic BookmanOldStyle-
Italic

BPSL.PS BookmanOldStyle

BPSD.PS BookmanOldStyle-
Bold

BPSDI.PS BookmanOldStyle-
BoldItalic

BPSLI.PS BookmanOldStyle-
Italic

TWEM.PS CenturyGothic

TWEB.PS CenturyGothic-Bold

TWEBI.PS CenturyGothic-
BoldItalic

TWEMI.PS CenturyGothic-Italic

CPS.PS CenturySchoolbook

CPSB.PS CenturySchoolbook-
Bold

CPSBI.PS CenturySchoolbook-
BoldItalic

CPSI.PS CenturySchoolbook-
Italic

COPS.PS Courier

COPSB.PS Courier-Bold

COPSBI.PS Courier-BoldItalic

COPSBO.PS Courier-BoldOblique Courier-BoldItalic

COPSI.PS Courier-Italic

COPSO.PS Courier-Oblique Courier-Italic

HVL.PS Helvetica Arial
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File Name PostScript Font Name Substitute Resource

HVLB.PS Helvetica-Bold Arial-Bold

HVLBO.PS Helvetica-BoldOblique Arial-BoldItalic

HVN.PS Helvetica-Narrow ArialNarrow

HVNB.PS Helvetica-Narrow-Bold ArialNarrow-Bold

HVNBO.PS Helvetica-Narrow-
BoldOblique

ArialNarrow-Bold

HVNO.PS Helvetica-Narrow-
Oblique

ArialNarrow-Italic

HVLO.PS Helvetica-Oblique Arial-Italic

MZC.PS MonotypeCorsiva

MZD.PS MonotypeSorts

NCB.PS NewCenturySchlbk-
Bold

CenturySchoolbook-
Bold

NCBI.PS NewCenturySchlbk-
BoldItalic

CenturySchoolbook-
BoldItalic

NCI.PS NewCenturySchlbk-
Italic

CenturySchoolbook-
Italic

NCR.PS NewCenturySchlbk-
Roman

CenturySchoolbook

POB.PS Palatino-Bold BookAntiqua-Bold

POBI.PS Palatino-BoldItalic BookAntiqua-
BoldItalic

POI.PS Palatino-Italic BookAntiqua-Italic

POR.PS Palatino-Roman BookAntiqua

SYPS.PS Symbol

TIB.PS Times-Bold TimesNewRoman-Bold

TIBI.PS Times-BoldItalic TimesNewRoman-
BoldItalic

TII.PS Times-Italic TimesNewRoman-Italic

TIR.PS Times-Roman TimesNewRoman

TIM.PS TimesNewRoman

TIMB.PS TimesNewRoman-Bold

TIMBI.PS TimesNewRoman-
BoldItalic
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TIMI.PS TimesNewRoman-Italic

ZC.PS ZapfChancery-
MediumItalic

MonotypeCorsiva

ZD.PS ZapfDingbats MonotypeSorts
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Appendix B

Tiling Workflow

Use the following procedure to properly tile images. 

Set Tiling Options

NOTE:	 The Tiling options MUST be set before tiling an image in the 
Display window.

Open the Tiling Options dialog. Turn the Include all Tiles in Layout 
button on or off as needed. Set Size from Layout Area to off. Set the 
width, height and overlap margins before scaling and tiling the image. 
If you have already scaled or tiled the image, you will need to do it 
again after setting the Tiling Options. 

The Layout width and height (in Printer Options) MUST be larger than 
the Tile width & height plus overlap margins (Tiling options menu). 
 
For example, if the panels are 48" x 96" with a 1" overlap, then the 
Layout must be at least 51" x 99". The extra space is required for the 
Overlap, Cut Marks and the Job Title. 
 
As a rule, add 5" to the Layout width and height as compared to the 
Tile setup width & height. If the Tile Overlap is more than 1", increase 
the layout width & height by the same amount (beyond the 5" extra). 
 
 

1.

2.
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If No Cropping and/or No Visual Resizing is Required:
Place the job that will be tiled into the Layout (Open file). In the File 
Info window, click the Scale/Rot button to open the Scale, Rotate, Tile 
tab of the Scaling dialog. In the Scale to Tile Size group, enter the num-
ber of Tiles and click the To Width or To Height button as needed. 

Click the Tile button and adjust panel sizes if required.

If Cropping or Visual Resizing is Required:
Place the file in the layout. Display & crop the file if needed. Once the 
file is cropped, click the Scale button at the bottom of the Display 
window (the far right icon). 

In the Scaling menu, enter the number of tiles in the Scale to Tile Size 
box and click the To Width or To Height button as needed. Click OK to 
go back to the Preview window. 

In the Display window, click the Tile icon (3rd from left) to view the Tile 
breaks. Click and Drag the Tile breaks as needed. 

Click the Tile icon again to open the Change Tiles dialog to view or 
enter the exact sizes per panel. To finish, click Save, then Save & Close 
in the Display window. 

NOTE:	 If you define the Tile Overlap to be zero and tile your image, 
and then set a tiling overlap other than zero, the overlap will 
move into the image, giving the image a windowpane effect. 
The Overlap allows space for framing between “window-
panes.” The Overlap and Trim values should be set to one half 
of the width of your desired “window frame.”

1.

2.

1.

2.

3.

4.


